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Avant-propos 
 
 
Ce manuel a été créé par Hologic® Inc. Il est destiné à guider l’utilisateur sur la façon de configurer, d’installer et d’utiliser le 
matériel Faxitron Path et le système logiciel Vision, tous deux développés par Hologic® Inc. 
 
Faxitron Path était auparavant connu sous le nom de PathVision 
 
L’utilisateur doit d’abord configurer le matériel, puis lancer le logiciel Vision. Veuillez consulter les procédures de configuration 
requises dans la section 2 de ce manuel avant de continuer. 
 
 
 
Indications thérapeutiques 
 
Le Faxitron Path est un système de radiographie monté dans une armoire. Il est utilisé pour produire des images sur film et/ou 
des images radiographiques numériques d’échantillons prélevés de diverses régions anatomiques, afin de vérifier rapidement 
que les tissus prévus ont été excisés pendant la procédure de biopsie. La possibilité de procéder à cette vérification directement 
dans la même pièce ou à proximité de celle où la procédure est effectuée accélère le déroulement des opérations et réduit ainsi 
la durée de l’examen du patient. La radiographie des échantillons peut potentiellement limiter le nombre de rappels des patients. 
 
Utilisation sur ordonnance (partie 21 CFR 801 sous-partie D) 
 
Attention : les lois fédérales limitent la vente de ce dispositif par un médecin ou sur ordonnance. 
 
 
Le système peut fonctionner comme un dispositif autonome. Si le dispositif est connecté à un réseau, il est essentiel de mettre 
en œuvre des mesures visant à réduire les risques pour les patients en réduisant la probabilité que les fonctionnalités du 
dispositif soient compromises, intentionnellement ou non, par une cybersécurité inadéquate. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

www.hologic.com/package-inserts 
 

http://www.hologic.com/package-inserts
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Ce manuel a été créé par Hologic Inc. Il est destiné à guider l’utilisateur expérimenté sur la 
façon de configurer, d’installer et d’utiliser le matériel du Faxitron Path et le logiciel Vision, 
tous deux développés par Hologic Inc. 

Lisez attentivement toutes ces informations avant d’utiliser le système. Respectez tous les 
avertissements et toutes les précautions énoncés dans ce manuel. Conservez ce manuel à 
disposition pendant les procédures. Respectez toujours toutes les instructions de ce manuel. 
Hologic, Inc. décline toute responsabilité en cas de blessure ou de dommage résultant d’une 
utilisation incorrecte du système. Hologic peut organiser une formation dans votre site. 

Merci de la part de nous tous à Hologic Inc. 

1.0.0 
Introduction 

Fabricant et coordonnées 

Hologic, Inc. 
600 Technology Drive 
Newark, DE 19702 États-Unis 
1-800-447-1856
www.hologic.com

PROMOTEUR DE L’AUSTRALIE 
Hologic (Australia and New Zealand) Pty Ltd 
Level 3, Suite 302 
2 Lyon Park Road 
Macquarie Park NSW 2113 
Australia
1-800-264-073

Hologic BV 
Da Vincilaan 5 
1930 Zaventem 
Belgique 
Téléphone : +32 2 711 46 80 
Télécopieur : +32 2 725 20 87 

Les symboles suivants sont utilisés dans ce manuel et dans le système d’aide en ligne : 

Avertit le lecteur d’un risque d’électrocution s’il ignore l’avertissement et utilise 
délibérément des outils spécialisés pour ouvrir une armoire électrique scellée 
et manipuler son contenu. Remarque : aucun outil n’est fourni par Hologic, Inc. 

Avertit le lecteur d’une situation dangereuse. Ce symbole est habituellement 
accompagné d’un symbole plus spécifique et d’instructions appropriées 
concernant la nature du danger, l’issue prévisible du danger et les informations 
permettant d’éviter le danger. 

Incite le lecteur à faire preuve de prudence lorsqu’il soulève du matériel lourd 
afin d’éviter les blessures corporelles et les dommages matériels. 

Avertit le lecteur qu’un rayonnement ionisé est émis dans la zone marquée 
lorsque le faisceau de rayons X est activé. Le Faxitron Path est muni de 
dispositifs de verrouillage de sécurité pour empêcher l’accès à la zone marquée 
pendant que le faisceau de rayons X est activé. 

Avertit le lecteur qu’il doit utiliser une protection appropriée (telle que des gants 
chirurgicaux ou un récipient pour échantillons approuvé) afin d’éviter toute 
exposition à des matières potentiellement infectieuses comme les échantillons 
de tissus des patients. 

1.1.0 
Symboles 
d’avertissement 
et de mise en 
garde de ce 
manuel 

http://www.hologic.com/
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Symbole Description 

 

Éliminez le matériel électronique et électrique 
séparément des déchets normaux. Renvoyez le 
matériel hors service à Hologic ou contactez votre 
représentant du service d’assistance. 

 

Fabricant 

 

Date de fabrication 

  

Mise en garde - rayonnement (production de 
rayons X) 

 

Mise en garde - matières potentiellement 
infectieuses 

 

Avertissement sur l’électricité 

 

Mise en garde 

   Suivez ou consultez le mode d’emploi 

 

Ce système émet de l’énergie de radiofréquence 
(RF) (rayonnement non ionisant) 

 
Représentant européen autorisé 

 
Dispositif médical 

 
Numéro du catalogue 

 
Numéro de série 

 

 
 
 

1.1.1 
Symboles 
d’avertissement et 
de mise en garde 
sur les étiquettes  
 

 
 

ou 

ou 
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SECTION 2 
Faxitron Path 

 Installation et 
configuration 

  

 
 
 
 



 
 

MANUEL DE L’UTILISATEUR DU FAXITRON PATH | HOLOGIC | RÉVISION 002 

SECTION 
Installation et 
configuration  2 

2-2 

Avertissements 
• Veuillez lire attentivement les instructions avant d’utiliser le système. 

• N’utilisez pas le système d’une manière autre que l’utilisation prévue, telle que décrite dans 
ce manuel. En cas de doute, contactez Hologic ou votre distributeur agréé. 

• Les cordons d’alimentation n’ont pas tous la même puissance. N’utilisez pas un autre 
cordon d’alimentation avec ce système que celui fourni. N’utilisez pas le cordon 
d’alimentation de ce système sur un autre équipement. 

• Ce système a été testé selon les normes internationales les plus strictes. Toutefois, il est 
recommandé de contacter les autorités nationales pour connaître les exigences 
opérationnelles locales. 

• Ce système n’est pas destiné à une utilisation publique. Il doit être situé dans une zone où 
le grand public ne peut pas accéder au système sans la présence d’un opérateur. 

Précautions générales 
Les précautions suivantes doivent être prises pour éviter d’endommager votre système Path : 

• Ne branchez ou débranchez jamais les câbles de communication et/ou d’alimentation 
lorsque le système de la caméra est sous tension. Des dommages au capteur CMOS ou 
aux composants électroniques de la caméra peuvent survenir si les câbles sont 
branchés/débranchés pendant que l’unité est sous tension. 

• Le système de détection est fragile et des précautions doivent être prises pour ne pas 
l’endommager. Le système de détection ne doit jamais être maltraité, heurté, cogné ou échappé. 

• Le système Path dispose d’un mode d’étalonnage. L’étalonnage doit être effectué 
quotidiennement pour assurer le bon fonctionnement du système. Veuillez consulter la 
procédure d’étalonnage. 

• Mise en garde - L’utilisation de commandes ou de réglages pour effectuer des procédures 
autres que celles spécifiées dans le présent document peut entraîner une exposition 
dangereuse au rayonnement. 

Connexions interopérables 
Le Path peut fonctionner comme un dispositif autonome sans aucune entrée ou sortie vers 
d’autres dispositifs. Les images peuvent être capturées, stockées et examinées directement 
sur le système. 

Toutefois, le système est livré avec plusieurs interfaces. L’interface principale est la connexion 
réseau qui permet au système d’être connecté à un système d’archivage et de transmission 
des images (PACS, Picture Archiving and Communication System). Ensuite, les images 
peuvent être transmises en format DICOM directement du dispositif au réseau de 
l’établissement à l’aide de notre logiciel. Consultez la section 6 pour obtenir plus de détails 
sur la version DICOM. Seuls des employés de Hologic ou le personnel informatique qualifié 
de l’établissement de l’utilisateur doivent configurer cette communication. 

Les connexions du système et leur utilisation prévue sont indiquées ci-dessous. Aucun 
autre type de dispositif ne doit être branché au Path sans l’approbation de Hologic. 

 2.1.0 
Avertissements 
et précautions 
relatifs au 
système 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 
 
 

Raccordement Usage Type de dispositif Utilisateur prévu 
Port Ethernet à 
l’arrière  

Pour stocker des images 
radiographiques sur un réseau de 
stockage de données 

PACS ou réseau 
de stockage 

Configuré par le personnel de Hologic ou 
du service informatique de l’établissement. 
Utilisé par les cliniciens. 

Port Ethernet à 
l’arrière 

Pour permettre une connexion à 
distance de l’équipe d’entretien de 
Hologic, à des fins de diagnostic et 
de réparation du système. 

Connexion internet 
en réseau 

Personnel de Hologic ou du service 
informatique de l’établissement 

Port USB à 
l’avant 

Pour transférer des images à partir 
du dispositif. Cette option doit être 
utilisée uniquement si le PACS ou le 
réseau n’est pas disponible. 

Périphérique de 
stockage USB (clé 
USB) 

Cliniciens ou personnel du service 
informatique disposant d’un accès autorisé 
au système. 
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Raccordement Usage Type de dispositif Utilisateur prévu 
Port USB à 
l’avant 

Pour l’entretien et la maintenance du 
système, il peut être nécessaire de 
copier les fichiers du système vers et 
depuis l’ordinateur, par exemple, les 
mises à jour du logiciel ou les 
fichiers journaux. 

Périphérique de 
stockage USB (clé 
USB) 

Personnel de Hologic ou du service 
informatique de l’établissement 

Port USB à 
l’arrière 

Pour permettre la connexion d’une 
imprimante. Le logiciel Vision permet 
de connecter une imprimante 
DICOM ou une imprimante standard 
compatible Windows. 

Imprimante 
DICOM ou 
Windows 

Cliniciens ou personnel du service 
informatique de l’établissement 

 
Cybersécurité 
La sécurité du dispositif est une responsabilité partagée entre Hologic et les établissements 
de soins de santé. Le fait de ne pas assurer la cybersécurité peut entraîner une détérioration 
des fonctionnalités du dispositif, la perte de disponibilité ou d’intégrité des données 
(médicales ou personnelles) ou l’exposition d’autres dispositifs ou réseaux connectés à des 
menaces de sécurité. Hologic effectue un ensemble de contrôles de cybersécurité pour 
assurer la cybersécurité de ses unités et maintenir leur fonctionnalité et leur sécurité. 

Toutes nos unités utilisent le système d’exploitation standard Windows. Lors de l’installation, 
nous recommandons à l’établissement de mettre en place toutes les mesures de sécurité 
nécessaires définies par leurs propres exigences internes, comme ils le feraient avec tout 
autre ordinateur connecté au réseau. 

Le personnel de l’établissement peut configurer le système d’exploitation Windows avec tous 
les protocoles de réseau et les autorisations nécessaires. Par exemple, il peut ajouter : 

 • des identifiants d’utilisateur et des mots de passe, 
• des autorisations par couches avec une authentification appropriée, 

 • des restrictions sur les installations de logiciels, 
 • des exigences relatives au contenu de confiance, y compris la vérification de la 

signature du code, 
 • la configuration des mises à jour de Windows, y compris les versions de sécurité. 

De plus, notre logiciel d’imagerie (Vision) peut être protégé par mot de passe, afin que certains 
utilisateurs puissent accéder au système d’exploitation sans pouvoir ouvrir le logiciel Vision. 

L’unité est livrée avec une clé physique qui permet d’activer le système de radiographie. 
Cela permet de verrouiller le système, de sorte que même si l’on accède au logiciel, aucune 
radiographie ne peut être lancée. 
 
Cette unité est conçue pour être utilisée comme unité autonome ou connectée au PACS 
interne de l’établissement ou à un autre réseau en boucle fermée. Elle n’est pas destinée à 
être connectée à l’Internet, à moins que (a) l’établissement reçoive des instructions 
spécifiques de la part de Hologic, ou que (b) l’établissement prenne des précautions 
adéquates pour assurer sa cybersécurité face aux menaces liées à sa connexion à l’Internet. 

Hologic développera des mises à jour ou des correctifs pour le logiciel Vision afin de 
continuer à assurer la sécurité du produit, selon les besoins, tout au long du cycle de vie de 
l’unité. 

Des mesures de sécurité supplémentaires, y compris le cryptage, peuvent être mises en 
œuvre et Hologic peut travailler avec le service informatique de l’établissement afin de 
réduire les risques pour les patients en cas de violation de la cybersécurité. 

 

 

 

 2.1.0 suite 
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Nettoyage 
Surfaces internes du compartiment 
Les échantillons biologiques peuvent contenir des agents infectieux qui sont dangereux pour 
votre santé. Veuillez suivre les procédures de biosécurité appropriées et : porter des gants 
lors de la manipulation des échantillons de tissus ou de tout matériel avec lequel ils sont 
entrés en contact. 

Essuyez régulièrement l’intérieur de l’armoire avec de l’alcool isopropylique à 70-90 % ou 
de l’hypochlorite de sodium dilué (5,25-6,15 % d’eau de Javel domestique diluée à 1:500 
fournit la concentration appropriée). Assurez-vous que la zone de l’échantillon, marquée sur 
le sol du compartiment, est nettoyée à fond. 

Surfaces externes du compartiment 
Essuyez régulièrement les surfaces externes avec de l’alcool isopropylique, de l’hypochlorite 
de sodium ou un savon doux et de l’eau (concentrations appropriées indiquées ci-dessus). 
Ne trempez pas ou n’inondez pas les surfaces et n’utilisez pas d’abrasifs qui pourraient rayer 
les surfaces. Ne laissez pas l’humidité entrer en contact avec les composants électriques du 
système. Testez les produits de nettoyage sur une petite zone non visible des capots en 
plastique et en métal pour vérifier qu’ils n’endommagent pas le revêtement. 

 
 
 
Inspection de la caisse 
Le système Faxitron Path est livré dans une grande caisse en bois et une boîte. Demandez 
à l’agent de transport de déposer la caisse et la boîte dans une zone à l’abri du vol, des 
dommages et des conditions environnementales extrêmes jusqu’à ce que le représentant 
autorisé de Hologic puisse installer le système. 

Vérifiez que la caisse et la boîte ne sont pas endommagées. Si l’une ou l’autre semble 
endommagée, contactez Hologic au 1-800-447-1856. 
La caisse mesure environ quatre pieds (1,2 mètres) de haut. Elle contient l’unité d’analyse 
des échantillons, l’ordinateur et les manuels du système. La boîte contient le moniteur du 
système. 

 

Levage et transport de la caisse 
Mise en garde : la caisse pèse environ 550 livres (250 kg). Le système emballé doit être 
maintenu à la verticale, comme indiqué sur la caisse d’expédition.  

 
Déballage et assemblage du système 
Le système Faxitron Path doit être déballé et assemblé sur place par un représentant 
autorisé de Hologic Inc. 

 

Emplacement 
Le système Faxitron Path est muni d’une ventilation et le connecteur d’entrée d’alimentation 
se trouve à l’arrière de l’armoire. Laissez au moins 6 pouces (15 cm) d’espace libre derrière 
l’unité une fois installé pour permettre à l’air de circuler et à l’utilisateur d’y accéder pour 
débrancher le cordon d’alimentation. 

 
 

 2.2.0 
Installation du 
système 
Faxitron Path 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
  



 
 

MANUEL DE L’UTILISATEUR DU FAXITRON PATH | HOLOGIC | RÉVISION 002 

SECTION 
Installation et 
configuration  2 

2-1 

Conditions environnementales 
En fonctionnement : 
Température : 15,5 à 30 degrés C ou 60 à 86 degrés F. 
Humidité relative : < 75 %. 
 
Stockage et transport : 
Température : 0 à 45 degrés C ou 32 à 113 degrés F. 
Humidité relative : < 75 %. 
 
 
Cet équipement a été conçu pour les conditions suivantes : 

• Utilisation intérieure 
• Altitude jusqu’à 2 000 mètres 
• Degré de pollution 2 
• Surtension de catégorie II 
 

Le Faxitron Path ne doit pas être déplacé après avoir été installé. Le système a été conçu 
comme une unité fixe qui doit être installée sur un comptoir ou une table. 

 
RADIOPROTECTION 
• Armoire blindée contre le rayonnement. 
• Porte de compartiment équipée d’un double verrouillage de sécurité. 
• Rayonnement : moins de 0,1 mR/h à 5 cm (2 po.) de la surface extérieure à la tension 

maximale (kV). 
• Certifié conforme aux normes établies par la Food and Drug Administration des États-Unis, 

Center for Devices and Radiological Health (21 CFR 1020.40). 
• Conçu pour être conforme aux normes établies par Underwriters Laboratory aux États-Unis 

et au Canada 
• Hologic recommande aux utilisateurs de suivre une formation en matière de protection 

de base contre le rayonnement ionisant avant d’utiliser le système. 
 
 
CONTRÔLE DE L’EXPOSITION : automatique ou manuel. 

CYCLE D’UTILISATION DES RAYONS X : 50 % 

INFORMATIONS SUR LE LASER : produit laser de classe 2 

CEI 60825-1 Éd. 3 

Conforme aux normes 21 CFR 1040.10 et 1040.11 à 
l’exception des écarts prévus par l’Avis sur les 
produits laser numéro 50, daté du 24 juin 2007. 

CARACTÉRISTIQUES ÉLECTRIQUES : 100-240 V CA, 50/60 Hz, 200 VA max 

PRODUCTION DE CHALEUR : 500 BTU/h max. 

Fluctuations de tension de l’alimentation secteur - ±10 % de la tension nominale 
 
Spécifications du tube à rayons X :  

Taille du point focal < 12 microns 
Tension - 20 à 100 Kv 
Puissance - 12 Watts max. 
Couverture du faisceau de rayonnement - 45 degrés 
Cycle d’utilisation des rayons X : 50 % 

 

 2.3.0 
Spécifications 
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DIMENSIONS EXTÉRIEURES (approximatives) 
 cm pouces 
Hauteur 90 36 
Largeur 59 23 
Profondeur 54 21 

 
 
DIMENSIONS INTÉRIEURES DU COMPARTIMENT (approximatives) 

 cm pouces 
Hauteur 57 22,3 
Largeur 39 15,5 
Profondeur 42 16,5 

 
 
POIDS (approximatif) 

 Avec ordinateur, moniteur, clavier et accessoires 
 kg lb 
Net 210 465 
Expédition 258 570 
 Armoire uniquement 
Net 188 415 
Expédition 236 520 
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Étalonnage 

Lors de la mise en service initiale du système ou à n’importe quel moment souhaité par 
l’utilisateur, un étalonnage du système peut être effectué. Lors de la mise en service initiale et 
toutes les douze (12) heures, les étalonnages suivants doivent être effectués. 

Pour optimiser la qualité d’image, le logiciel Vision et le matériel nécessitent un étalonnage à 
intervalles réguliers. Cet étalonnage nécessite l’acquisition d’images de référence. Ces images 
peuvent être regroupées en trois (3) catégories : images décalées, images sombres et images 
de champ plat. 

Le logiciel Vision s’ouvrira directement sur le menu d’accueil (Figure 3.1.1) ou sur la 
page Calibration (Étalonnage) (Figure 3.1.2), en fonction du temps écoulé depuis le 
dernier étalonnage. L’utilisateur peut naviguer vers la page « Calibration » 
(Étalonnage) pour démarrer manuellement un étalonnage.  

Mise en garde : vérifiez que le compartiment est vide avant de commencer l’étalonnage. 

Pour démarrer manuellement l’étalonnage, cliquez sur le bouton « Calibrate » (Étalonnage) 
dans le menu d’accueil. 

 
 
 
 
 
 
 
 
 
 
 
 
L’utilisateur sera alors invité à démarrer l’étalonnage. 
 
 
 
 

 
 

 
 
 
 
 

Une fois ce bouton enfoncé, le processus d’étalonnage est réalisé et la boîte de dialogue de 
l’étalonnage est affiché. Pendant l’étalonnage, la boîte de dialogue alterne entre « SYSTEM 
IN CALIBRATION » (SYSTÈME EN COURS D’ÉTALONNAGE) et « X-RAY ON » (RAYONS X 
ACTIVÉS; voir Figure 3.1.3).  
 
 
 
 
 
 
 
 
 

Une fois l’étalonnage terminé, le menu d’accueil est affiché automatiquement 
 
Consultez les sections 5.2.0 et 5.2.1 pour obtenir plus d’informations sur l’étalonnage. 

 3.1.0 
Étalonnage  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 3.1.1  
Bouton « Calibrate » (Étalonner) 
du système  
 
 
 
 
 
 
 
 
 
Figure 3.1.2 
Invite au démarrage de 
l’étalonnage 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 3.1.3  
Progression de l’étalonnage 
 
 
 
 
 
 
 
 

 



 
 
 

MANUEL DE L’UTILISATEUR DU FAXITRON PATH | HOLOGIC | RÉVISION 002   

SECTION 
Démarrage 
rapide 4 

4-1 

4 

 

SECTION 4 
Démarrage rapide - 

Fonctionnement de base 
du Faxitron Path 
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Avant de mettre le système sous tension, assurez-vous que tous les cordons et câbles sont 
branchés correctement au système, à l’ordinateur et au moniteur. 

Consultez la Section 2 Installation et configuration de ce manuel, ainsi qu’aux guides 
d’installation et de démarrage rapide fournis avec votre système Path. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Protocole de la séquence de démarrage du système 

Cette séquence de démarrage doit être respectée pour assurer le bon fonctionnement du 
système et la qualité des images. 

Mise sous tension du système 

• Placez l’interrupteur à l’arrière de l’armoire du Path en position « MARCHE ». 
• Tournez la clé située à l’avant de l’armoire du Path en position « MARCHE » (dans 

le sens des aiguilles d’une montre jusqu’à la position de « 3 heures »). 
• Allumez l’ordinateur et le moniteur. 

Démarrage du logiciel 

• Vérifiez que le compartiment à rayons X du Path est vide. 
• Le logiciel Vision devrait démarrer automatiquement lorsque le 

système d’exploitation Windows a achevé son démarrage. Si le 
logiciel ne démarre pas automatiquement, faites un double clic sur 
l’icône Vision situé sur le bureau de Windows. 

Étalonnage 

• Au premier démarrage de la journée, le logiciel devrait s’ouvrir à la page Étalonnage. 
• Appuyez sur le bouton « Calibrate » (Étalonner) et patientez jusqu’à ce que le système 

termine l’étalonnage. 

Recommandations supplémentaires pour une qualité d’image cohérente 

Laissez le système effectuer un étalonnage complet tous les jours avant sa première 
utilisation. Le système est configuré pour effectuer cet étalonnage lorsque vous démarrez le 
logiciel Vision. 

Effectuez un étalonnage complet du système après avoir déplacé le système dans une autre 
pièce, afin d’éviter les problèmes d’imagerie potentiels associés aux différences de 
température et d’humidité ambiante d’une pièce à l’autre. 

 4.1.0 
Démarrage rapide 
 
 
 
Figure 4.1.1 
Panneau avant du Path 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.1.2 
Icône Vision sur le bureau 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

Clé 
March
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Procédures d’imagerie de base 

Avertissement : l’utilisation du Path d’une manière autre que celle décrite dans ce manuel 
peut entrainer un mauvais fonctionnement de l’équipement ou causer des blessures 
corporelles. 

Avertissement : utilisez des récipients ou des gants approuvés afin d’éviter tout contact avec 
des échantillons de tissus de patients potentiellement dangereux. 

Démarrage de la procédure 

• Sur la page du menu d’accueil, sélectionnez le bouton Start Procedure (Démarrer 
la procédure). 

 

 

 

 

 

 

 

 

 

• L’utilisateur pourra choisir entre Select from Work List, Manual Entry, Select from 
Database (Sélectionner dans la liste de travail, Saisie manuelle, Sélectionner dans 
la base de données) ou Continue with current patient (Continuer avec le patient 
actuel). 

• Pour saisir manuellement une nouvelle procédure, sélectionnez le bouton Manual 
Entry (Saisie manuelle). 

 

 

 

 

 

 

 

• La boîte de dialogue « Patient Information Editor » (Éditeur d’informations sur le 
patient) s’ouvre. 

 

 4.2.0 
Acquisition 
d’images 

 
 
 
 
Figure 4.1.3 
Menu d’accueil du programme 
Vision (écran principal) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.1.4 
Options de la procédure de 
démarrage 
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Remarque : les champs obligatoires sont indiqués par un 
astérisque blanc (*). 
Les champs obligatoires par défaut sont « Patient Name » (Nom 
du patient), « Patient ID » (ID du patient), « Accession Number » 
(Numéro d’ordre) et « Laterality » (Latéralité). 

• Remplissez tous les champs obligatoires. Le bouton Accept (Accepter) ne sera pas 
actif si l’un des champs obligatoires n’est pas rempli. L’utilisateur peut remplir 
d’autres champs s’il le souhaite. 

Remarque : la date de naissance doit être saisie en format aaaa/mm/jj (p. ex., 1962/08/13).  

• Sélectionnez Accept (Accepter) pour activer l’acquisition d’images. 

Imagerie à rayons X 

• Placez le(s) échantillon(s) dans un récipient pour échantillon fourni par Hologic, Inc. ou par 
votre établissement et déposez-le(s) à l’intérieur du compartiment à rayons X. La zone 
d’imagerie est délimitée par un autocollant. (L’utilisateur peut également placer l’échantillon 
et le récipient sur le plateau d’agrandissement fourni avec le système Path. 

• Appuyez sur le bouton vert Start X-ray (Démarrer les rayons X) (dans le logiciel ou sur le 
panneau avant de l’armoire à rayons X) pour lancer l’acquisition d’images/de radiographies. 

• Attendez que l’image soit affichée. 
Remarque : lorsque le mode « Full Auto » (Entièrement automatique) est sélectionné, deux 
radiographies sont prises, la première pour déterminer les meilleurs réglages et la seconde 
pour l’image elle-même. Les réglages utilisés pendant l’exposition (tension en kV et durée) 
seront affichés sur l’écran LCD de l’armoire. 
 

 4.2.0 suite 
 
Figure 4.1.5 
Écran des données du patient 
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 Le logiciel Vision est configuré pour enregistrer automatiquement l’image dans la base de 
données Faxitron sur le disque local de l’ordinateur du système. L’utilisateur peut également 
enregistrer l’image sur le serveur de l’établissement en cliquant sur l’icône PACS (voir 
Figure 4.1.6). 
 

 
Si vous souhaitez obtenir plus d’informations sur le réglage des paramètres d’image, des 
commandes de rayons X et des options d’analyse et d’enregistrement, consultez la Section 5. 

 4.2.0 suite 
 
Figure 4.1.6 
Écran affichant une image 
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Le logiciel Vision est un ensemble complet d’acquisition et de traitement d’images, conçu 
exclusivement pour fonctionner avec les générateurs de rayons X de Faxitron (tels que les 
systèmes VersaVision, PathVision, CoreVision et BioVision). En plus des fonctions d’acquisition 
et de traitement, le logiciel offre un module de base de données complet qui permet à 
l’utilisateur de contrôler et de gérer l’archivage, le stockage, le classement et la récupération 
des images. Le logiciel est également conforme à la norme DICOM (Digital Imaging and 
Communications in Medicine, Imagerie numérique et communication en médecine), ce qui 
permet d’enregistrer et d’imprimer des images du patient en format DICOM 3.0. Le logiciel a 
été préinstallé sur l’ordinateur livré avec votre système de radiographie. 

L’étalonnage du système est requis au début de chaque nouvelle journée d’utilisation du 
système pour garantir la meilleure qualité d’image. L’utilisateur du système peut également 
effectuer un étalonnage à tout moment pour garantir une qualité d’image optimale. 

Après l’étalonnage, le menu d’accueil s’affiche, ce qui permet de naviguer vers toutes les autres 
zones du logiciel. Des boutons d’application sont disponibles pour faciliter son utilisation (voir 
Figure 5.0.1). Ces boutons se trouvent au centre de l’écran. Les descriptions et les définitions 
des boutons sont présentées dans les sections suivantes de ce manuel.  

Protocole de séquence 
La séquence de démarrage doit être respectée pour assurer le bon fonctionnement du système 
et la qualité des images. 

Mettez l’armoire Faxitron Path sous tension à l’aide de l’interrupteur situé à l’arrière de l’armoire 
(interrupteur principal situé à côté de la prise du cordon d’alimentation). Faites basculer sur 
« I » pour mettre en position « MARCHE » et sur « 0 » pour mettre en position « ARRÊT ». 

Allumez l’armoire Faxitron Path en insérant la clé Faxitron Path dans l’interrupteur à clé situé 
sur le panneau avant, et en la tournant dans le sens des aiguilles d’une montre jusqu’à la 
position de « 3 heures ». Remarque : la clé ne peut pas être retirée dans cette position. 

Allumez l’ordinateur et le moniteur. 

Le logiciel Vision démarre automatiquement lorsque Windows a terminé sa 
séquence de démarrage. Une boîte de dialogue apparaît pour indiquer que 
le logiciel a été initialisé et chargé. REMARQUE : si Vision ne démarre pas 
automatiquement, double-cliquez avec le bouton gauche de la souris sur 
l’icône du logiciel Vision située sur le bureau de Windows (voir Figure 5.1.1). 

Le logiciel Vision s’ouvre sur le menu d’accueil ou sur la page d’étalonnage, 
en fonction du temps écoulé depuis le dernier étalonnage du système. 

Consultez la Section 3, « Étalonnage de la caméra », et la Section 5.2.1, « Aperçu de l’étalonnage 
de la caméra » pour connaître les protocoles d’étalonnage. 

 5.0.0 
Aperçu du logiciel 
Vision 

Figure 5.0.1  
Logiciel Vision  
Menu d’accueil (écran de 
démarrage) 

5.1.0 
Démarrage du 
logiciel 

Figure 5.1.1 
Icône du logiciel Vision sur le 
bureau 
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Introduction sur l’étalonnage 
 
Pour optimiser la qualité d’image, le logiciel Vision et le matériel nécessitent un étalonnage à 
intervalles réguliers. Cet étalonnage nécessite l’acquisition d’images de référence. 

Lors de la mise en service initiale du système ou à n’importe quel moment souhaité par 
l’utilisateur, un étalonnage du système peut être demandé et effectué. Il est recommandé 
d’effectuer les étalonnages suivants tous les douze (12) heures. 

Ces images d’étalonnage de référence sont utilisées pour étalonner une image radiographique 
« brute » pixel par pixel, afin de générer une image « corrigée » pour l’affichage. Les corrections 
d’image effectuées comprennent des corrections de gain, de décalage et de linéarité. 

 

Séquence d’étalonnage 
 
Pour plus de commodité, le logiciel Vision combine les nombreuses étapes d’étalonnage en 
une étape unique. 

Lorsqu’un système de radiographie Faxitron a été éteint pendant plus de douze (12) heures, le 
système demande automatiquement un nouvel étalonnage. Il est fortement recommandé 
d’étalonner le système à nouveau après une longue période d’inactivité, ou après avoir déplacé 
le système dans une autre pièce où les paramètres de température/humidité ambiante peuvent 
être différents.  

Pour étalonner le système à tout moment, cliquez sur le bouton 
Calibrate (Étalonner) sur le menu d’accueil de Vision (écran de 
démarrage), puis appuyez sur Start Calibration (Démarrer l’étalonnage) 
(voir Figures 5.2.1 et 5.2.2). La boîte de dialogue affiche un message 
d’état pendant l’étalonnage (voir Figure 5.2.3). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pendant l’étalonnage, des rayons X peuvent être générés. Pendant la génération des rayons X, 
un bouton Stop X-Ray (Arrêter les rayons X) devient visible pour permettre à l’utilisateur 
d’arrêter les rayons X à partir du logiciel. 

 5.2.0 
Aperçu de 
l’étalonnage de la 
caméra 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.2.1  
Bouton Calibrate (Étalonner) du 
menu d’accueil  
 
 
 
 
 
 
 
 
Figure 5.2.2 
Bouton Start Calibrate (Démarrer 
l’étalonnage) 
 
 
 
 
 
 
 

Figure 5.2.3 
État de l’étalonnage 
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Il est parfois préférable d’incorporer les caractéristiques d’atténuation des rayons X d’un 
atténuateur uniforme dans les images d’étalonnage de référence en champ plat. Par exemple, 
si tous les objets qui doivent être balayés sont placés sur une mince plaque de plastique, les 
caractéristiques d’atténuation des rayons X de la plaque seront observées dans chaque image 
acquise. Dans ce cas, le fait de placer la plaque dans le faisceau de rayons X pendant 
l’acquisition de l’image d’étalonnage de référence en champ plat pourrait améliorer la qualité 
de l’image. Voici un résumé du protocole d’étalonnage avancé pour « Both » (Les deux) (le 
champ plat et l’image) : 
Placez l’atténuateur uniforme sur le capteur. Toute la surface du capteur doit être couverte par 
l’atténuateur. Pour optimiser les résultats, l’atténuateur doit être plus grand que la zone d’imagerie du 
capteur. 

Sur l’écran de démarrage du logiciel d’imagerie, appuyez sur l’icône ^ situé en haut à droite 
pour faire apparaître le menu. Sélectionnez l’élément du menu déroulant « Tools » (Outils) dans 
la barre de menu supérieure, puis passez de « Advanced Tools » (Outils avancés) à « X-Ray 
Calibration/Exposure Setup » (Étalonnage des rayons X/Configuration de l’exposition). 

REMARQUE : Les valeurs de tension (kV), de durée d’exposition et d’unités analogiques-
numériques (ADU) peuvent différer de celles indiquées. 

• Sous « X-Ray Generator and Exposure Settings » (Générateur de rayons X et paramètres 
d’exposition), saisissez le réglage de la tension (kV) du générateur dans le champ approprié. 

• Définissez une valeur pour « Magnification » (Agrandissement) ou laissez le réglage par 
défaut de un (1,0). 

• Sélectionnez le bouton « Set for » (Régler pour) « Both » (Les deux) dans la boîte de dialogue. 
• Conservez le réglage par défaut « user ADU target » (cible d’unité analogique-numérique de 

l’utilisateur). L’exposition aux rayons X sera terminée lorsque le capteur aura accumulé un 
niveau de signal moyen en unités analogiques-numériques acceptable pour votre générateur 
de rayons X. 

• Conservez la durée d’exposition par défaut du test et cliquez sur le bouton Acquire (Acquérir). Le 
système commencera automatiquement l’émission de rayons X et fera l’acquisition d’une image. 

• Lorsque l’exposition aux rayons X est terminée, cliquez sur le bouton Estimate/Calculate 
(Estimer/Calculer). 

• Enregistrez la valeur de la durée d’exposition calculée « Time [s] » (Durée [s]). Le système 
calcule cette durée et le nombre est affiché en gris. 

• Saisissez la durée d’exposition calculée de « Time [s] » (Durée [s]) dans la zone le champ 
« Test Exposure » (Exposition de test). Appuyez sur le bouton Acquire (Acquérir) pour lancer 
automatiquement l’émission de rayons X et l’acquisition d’une image. 

 5.2.1 
Étalonnage avancé 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.2.4 
Boîte de dialogue X-Ray 
Generator and Exposure Settings 
(Réglages du générateur de 
rayons X et de l’exposition) 
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• Lorsque l’exposition aux rayons X est terminée, cliquez sur le bouton Estimate/Calculate 
(Estimer/Calculer). 

• Enregistrez la valeur de la durée d’exposition calculée « Time [s] » (Durée [s]). 

• Saisissez à nouveau la valeur de la durée d’exposition calculée dans le champ « Test 
Exposure » (Exposition de test). 

• Cliquez sur le bouton Accept Settings (Accepter les paramètres). 

• Effectuez une procédure d’étalonnage standard, tel que décrit dans la section « Aperçu de 
l’étalonnage de la caméra ».  

Les utilisateurs expérimentés pourraient vouloir régler les paramètres d’exposition « X-Ray Cal 
(Flat-Field) » (Étalonnage des rayons X [champ plat]) et « Manual Image » (Image manuelle) 
indépendamment ou « Both » (Les deux) (champ plat et image manuelle), tel que décrit 
précédemment. En sélectionnant le bouton radio « Flat Field » (Champ plat), le système 
détermine la durée d’exposition optimale pour l’acquisition d’images en champ plat avec le 
niveau d’unité analogique-numérique (ADU) souhaité. Par conséquent, la sélection de 
« Manual Image » (Image manuelle) déterminera la durée d’exposition optimale pour le 
système avec un objet qui atténuera les rayons X. Pour obtenir de meilleurs résultats, toute la 
zone d’imagerie du capteur doit être recouverte par l’objet. 

Après avoir sélectionné « X-Ray Cal (Flat-Field) » (Étalonnage des rayons X [champ plat]) et 
« Manual Image » (Image manuelle) et avoir réglé le niveau d’unité analogique-numérique 
(ADU), sélectionnez le bouton Acquire (Acquérir). Pour la sélection « Manual Image » (Image 
manuelle), il est préférable que l’objet ou l’atténuateur de rayons X soit dans le faisceau de 
rayons X. Appuyez sur le bouton Acquire (Acquérir) pour générer des rayons X et obtenir une 
image. Lorsque l’exposition aux rayons X est terminée, cliquez sur le bouton 
Estimate/Calculate (Estimer/Calculer). Le système calcule la durée optimale et le nombre est 
affiché en gris. Cliquez sur le bouton Accept Settings (Accepter les paramètres) pour 
enregistrer les paramètres d’exposition dans le fichier de configuration du système. 
Remarque : seuls les réglages du bouton radio sélectionné sont enregistrés. Ensuite, 
effectuez une procédure d’étalonnage standard, tel que décrit dans la section « Aperçu de 
l’étalonnage de la caméra ». 

 5.2.1 suite 

 
 
 
 

Le bouton Start Procedure (Démarrer la procédure) (voir Figure 5.0.1) permet à l’utilisateur 
d’accéder à la page « Patient Data Entry » (Saisie des données du patient) qui propose 
différentes méthodes pour saisir les données du patient. Si aucune liste de travail n’a été 
configurée, l’option sera affichée en gris et seules les options Continue with current patient, 
Manual Entry, Select from Database (Continuer avec le patient actuel, Saisie manuelle et 
Sélectionner dans la base de données) seront accessibles. Les options sont expliquées dans 
les sections suivantes. 
 

 

 5.3.0 
Données du patient 
 
 
 
 
 
 
Figure 5.3.1 
Écran de saisie des données du 
patient 
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SÉLECTIONNER DANS LA LISTE DE TRAVAIL (liste de travail des 
modalités à distance) 

Si une liste de travail a été configurée, l’utilisateur peut cliquer sur le bouton Select from Work 
List (Sélectionner dans la liste de travail) pour afficher la page suivante (voir Figure 5.3.2 ci-
dessous). 

 

 

Les différents filtres sur la gauche peuvent être utilisés pour rechercher des procédures 
programmées pour l’entité d’application (EA) de la station de travail. Vérifiez que le titre de l’EA 
de la station de travail est défini, puis n’importe quel champ ou combinaison de champs peut 
être utilisé comme filtre pour rechercher des procédures planifiées pour cette EA. En 
sélectionnant le bouton Query (Interroger) situé dans le coin inférieur gauche, le tableau est 
rempli à nouveau avec les entrées correspondant aux informations recherchées. 

L’utilisateur peut alors cliquer sur n’importe quelle entrée, puis sur Submit (Soumettre) pour 
remplir automatiquement l’éditeur des informations d’imagerie avec les informations sur le 
patient. 

REMARQUE : l’utilisateur peut également double-cliquer sur n’importe quelle saisie du tableau 
pour accéder rapidement à l’éditeur des informations d’imagerie sans avoir à appuyer sur 
Submit (Soumettre). 

La boîte de dialogue « Patient Information Editor » (Éditeur des informations sur le patient) 
s’ouvre (voir Figure 5.3.3). Remplissez les autres champs obligatoires et cliquez sur Accept 
(Accepter) pour procéder à l’acquisition d’images.  

 

 5.3.1 
Sélectionner dans 
la liste de travail 
 
 
 
 
 
Figure 5.3.2 
Boîte de dialogue Modality 
Worklist Search (Rechercher 
dans la liste de travail des 
modalités) 
 
 

 
 
 
 
 
 
 
 
 
 

REMARQUE : toutes les données du 
patient sont fictives. 
Toute ressemblance avec une 
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Remarque : les champs obligatoires sont indiqués par un astérisque blanc (*). Les champs 
obligatoires par défaut sont « Patient Name » (Nom du patient), « Patient ID » (ID du patient), 
« Accession Number » (Numéro d’ordre) et « Laterality » (Latéralité). 
 
L’utilisateur doit remplir tous les champs 
obligatoires avant de pouvoir sélectionner le 
bouton Accept (Accepter). L’utilisateur peut 
également saisir la date, le nom du médecin 
traitant, le nom de la procédure, le sexe, le nom 
du technicien, la vue de la position, la partie du 
corps et l’identifiant de l’étude, si nécessaire. 
Le nom de la procédure, la vue de la position et 
la partie du corps sont sélectionnés dans un 
menu déroulant. 
 
Remarque : la date doit être saisie en format 

aaaa/mm/jj (p. ex., 1962/08/13). 
La saisie d’une date non valide 
peut entraîner des erreurs lors de 
la récupération des images. 

 
Remarque : les « champs obligatoires » peuvent 

être modifiés ou supprimés, selon 
l’application. Contactez le service 
d’assistance de Hologic pour 
obtenir plus d’informations. 

 
Sélectionnez Accept (Accepter) pour accepter 
ou Start a New Patient or Procedure (Démarrer 
un nouveau patient ou une nouvelle procédure) 
pour revenir à la page de saisie des données 
du patient. 

 5.3.1 suite 
 
 
Figure 5.3.3 
Éditeur des informations 
d’imagerie 
 
 
 
 

 
 
 

Continuer avec le patient actuel 
 
 
Cliquez sur ce bouton Continue with current patient (Continuer avec le patient actuel). 
L’éditeur des informations d’imagerie s’ouvre (voir Figure 5.3.3). Suivez la procédure et les 
remarques ci-dessus. 
 

 5.3.2 
Continuer avec le 
patient actuel 

 
 
 

Saisie manuelle 
 
 
Cliquez sur ce bouton pour saisir manuellement une nouvelle procédure. L’éditeur des 
informations d’imagerie s’ouvre (voir Figure 5.3.3). Suivez la procédure et les remarques ci-
dessus. 
 

 5.3.3 
Saisie manuelle 
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Sélectionner dans la base de données 
 
Cliquez sur le bouton Select from Database (Sélectionner dans la base de données) pour 
afficher la page suivante (voir Figure 5.3.4 ci-dessous). 

 
 
L’utilisateur sélectionne le patient dans le tableau situé sur le côté droit de la page, puis clique 
sur le bouton Accept (Accepter) qui ouvre l’éditeur des informations d’imagerie. (Remarque : 
l’utilisateur peut également double-cliquer sur l’entrée dans le tableau pour ouvrir l’éditeur des 
informations d’imagerie. Ensuite, suivez la procédure et les remarques de la page 5.7. 
 
Remarque : utilisez la barre de défilement située en bas de l’écran pour afficher les 
informations sur le patient qui sont masquées. 
 
Vision permet à l’utilisateur de restreindre la liste des patients en saisissant des informations 
spécifiques dans la fenêtre « Search Parameters » (Paramètres de recherche) située sur le 
côté gauche de la page. Seuls les patients qui respectent tous les paramètres de recherche 
seront affichés.  
 

 5.3.4 
Sélectionner dans 
la base de données 
 
Figure 5.3.4 
Sélection du patient à partir des 
entrées de la base de données 
locale 
 
 

 
 
 

REMARQUE : toutes les données du 
patient sont fictives. 
Toute ressemblance avec une personne 
réelle est strictement une coïncidence. 
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Si l’utilisateur souhaite modifier ou afficher les informations après leur saisie, mais 
avant la prise d’une image, il peut appuyer sur l’icône Patient Data (Données du 
patient) dans le coin supérieur gauche (voir Figure 5.3.5). 

 

 

La fenêtre de l’éditeur des informations sur le patient/d’imagerie s’ouvre. Cette fenêtre de 
modifications sera remplie avec toutes les informations précédemment saisies ou sélectionnées 
(voir Figure 5.3.6). Remarque : La fenêtre de modifications comprendra désormais un bouton 
Cancel (Annuler). 

L’utilisateur peut modifier ou ajouter des 
informations, si nécessaire, puis cliquer sur : 

• le bouton Accept (Accepter) pour enregistrer 
les modifications et poursuivre l’acquisition 
d’images. 

• le boutonCancel (Annuler) pour annuler les 
modifications et poursuivre l’acquisition 
d’images. Le logiciel reviendra aux 
informations saisies initialement sur le 
patient, ou 

• le boutonStart a New Patient or Procedure 
(Démarrer un nouveau patient ou une 
nouvelle procédure) pour ramener 
l’utilisateur à l’écran « Patient Data Entry » 
(Saisie des données du patient) (voir 
Figure 5.3.1). 

  

 

 
 
 

 

 

 

 

 

 

 

 

Une fois que l’utilisateur a cliqué sur le bouton Accept (Accepter), le système est prêt pour 
l’acquisition d’images/de radiographies. 

Les rayons X sont générés en appuyant sur le bouton vert Start (Démarrer) situé à l’avant de 
l’armoire Faxitron Path ou en cliquant sur le bouton Start X-Ray (Démarrer les rayons X) situé 
dans le coin inférieur droit de l’écran (voir la Section 4.2.0, Acquisition d’images). Le système 
prendra une courte radiographie « d’échantillon », ou pré-image (expliquée à la Section 5.4.4), 
suivie d’une exposition plus longue pour acquérir l’image. Le logiciel traite l’image avant de 
l’afficher sur l’écran du moniteur. Une fois l’image affichée, les boutons situés à gauche et à 
droite de l’écran, couverts tout au long de cette section, seront activés. 

 5.3.5 
Icône des données 
du patient 
 
Figure 5.3.5 
Icône des données du patient 
 
 
 
 

Figure 5.3.6 
Boîte de dialogue Image 
Properties (Propriétés de l’image) 
 
 
 
 
 

 



 
 

MANUEL DE L’UTILISATEUR DU FAXITRON PATH | HOLOGIC | RÉVISION 002   

SECTION 
Logiciel VISION 5 

5-10 

 
 
 
 
 
L’utilisateur peut afficher, mais pas modifier, les 
informations sur le patient après l’acquisition d’une 
image en cliquant sur l’icône Patient Data (Données 
du patient) présentée à la Figure 5.3.5. Une boîte de 
dialogue présentant les informations modifiées sur le 
patient s’affiche, comme le montre la Figure 5.3.7. 
Cette boîte contient deux boutons : Close Dialog 
(Fermer la boîte de dialogue) et Start a New Patient 
or Procedure (Démarrer un nouveau patient ou une 
nouvelle procédure).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Après la prise d’une image, les informations sur l’image actuelle (propriétés de 
l’image) peuvent être affichées en appuyant sur l’icône (i) dans le coin supérieur 
droit, comme le montre la Figure 5.3.8. La boîte de dialogue « Image Properties » 
(Propriétés de l’image) s’affiche dans le coin supérieur droit de l’image. La boîte est 
semi-transparente pour permettre de voir ce qui se trouve en-dessous (voir 
Figure 5.3.9). 
 

 5.3.5 suite 
 
 
Figure 5.3.7 
Boîte de dialogue Patient 
Information (Informations sur le 
patient) après l’acquisition 
d’images 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.3.8 
Icône des propriétés de l’image 
 
 
 
 
 
Figure 5.3.9 
Boîte de dialogue Image 
Properties (Propriétés de l’image) 
(affichage uniquement) 
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Le logiciel Vision fournit plusieurs outils et menus pour contrôler les attributs ou paramètres des 
images, l’acquisition de radiographies, les vues d’image, les outils d’image et les 
paramètres/accès DICOM. Les outils les plus couramment utilisés se trouvent dans une barre 
d’outils. La barre d’outils et les menus sont décrits plus en détail dans les pages suivantes. 

 
Le logiciel Vision permet d’accéder d’un seul clic à un certain nombre d’outils et de fonctions 
couramment utilisés à partir d’une barre d’outils verticale située sur le côté gauche de l’écran. 
Des descriptions détaillées sont présentées dans les pages suivantes (voir Figure 5.4.1). 

 
 
Afficher/modifier les informations sur le patient 
(voir Section 6.3.5 et Figure 6.3.5) 
 
 
 
Icône de rehaussement de l’image 
 
 
 
Contraste et niveau de la fenêtre 
 
 
 
Zoom numérique 
 
 
 
Annotations 
 
 
 

Enregistrement PACS 
 
 
 

Impression PACS 

 

Contrôle de l’exposition (panneau de commande du dispositif) 

 

 
Retour au menu principal 

 

 
Arrêt du système 

 

 5.4.0 
Barre d’outils et 
menus 
 
 
5.4.1 
Barre d’outils 
latérale 
 
 
Figure 5.4.1 
Barre d’outils latérale 
 
 
 

 
 
 
 
 
 

REMARQUES :  
 
Les outils suivants sont toujours 
actifs dans la page d’acquisition 
d’images : 
• Afficher/modifier les informations 

sur le patient 
• Contrôle de l’exposition, 
• Retour au menu principal, et  
• Arrêt du système 
 
Les outils suivants seront désactivés 
après la saisie des données du 
patient et ils seront activés 
uniquement après l’acquisition d’une 
image radiographique : 
• Rehaussement de l’image, 
• Contraste et niveau de la fenêtre, 
• Zoom numérique, et 
• Annotation 
 
Les outils d’enregistrement PACS et 
d’impression PACS sont activés 
uniquement après l’acquisition d’une 
image radiographique et lorsque le 
système est connecté à un réseau 
PACS. 
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Rehaussement de l’image 
Le bouton présenté à la Figure 5.4.2 traite l’image sur l’écran pour mettre en évidence les détails 
plus petits, tels que les micro-calcifications et les petites masses dans l’image. 

 

 

L’algorithme, communément appelé « Peripheral Equalization » (Égalisation périphérique) ou 
« Thickness Equalization » (Égalisation de l’épaisseur) en imagerie avancée, est appliqué à 
l’ensemble de l’image. En plus de cet algorithme, Hologic utilise un second algorithme 
développé à l’interne appelé « Calcification Emphasis » (rechaussement de la calcification). Cet 
algorithme secondaire a été conçu pour faire ressortir les petits détails de l’image et les rendre 
beaucoup plus faciles à voir et à analyser. 

Étant donné que les images des patients constituent une catégorie plus générale pour les 
géométries et les différentes épaisseurs possibles, certains échantillons peuvent avoir des 
géométries complexes et l’utilisateur doit utiliser cet outil avec prudence. 

Le système sera inactif (en veille) pendant le traitement et une fois le traitement terminé, le 
bouton restera enfoncé/actif. L’utilisateur peut annuler le processus en appuyant à nouveau sur 
le bouton.  

 5.4.1 suite 
 
Figure 5.4.2 
Icône du rehaussement de 
l’image 
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Réglage de l’inversion, du niveau de la fenêtre et du contraste de 
l’image 

 
Le bouton présenté à la Figure 5.4.3 ouvre l’outil de réglage du niveau de la fenêtre et du contraste 
de l’image. Cet outil permet à l’utilisateur d’ajuster le niveau de la fenêtre et le contraste de l’image, 
de rétablir le contraste d’origine en appuyant sur le bouton Original Contrast (Contraste 
d’origine) ou d’inverser l’image en appuyant sur le bouton Invert (Inverser). L’inversion fait 
passer la palette de couleurs d’une prédominance de noir à une prédominance de blanc et vice 
versa (voir Figure 5.4.4 ci-dessous). 
 
 
 
 
 
 
 
 
 
 
 
L’utilisateur peut également ajuster le contraste 
d’image désiré en cliquant sur le curseur et en la 
déplaçant vers le haut ou vers le bas, ou en cliquant 
sur l’une des flèches indiquées sur la barre pour 
déplacer les limites inférieures ou supérieures du 
niveau de la fenêtre (voir Figure 5.4.3). Cette 
fonction est officieusement connue sous le nom de 
« Window Leveling » (Mise à niveau de la fenêtre). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Un exemple d’inversion est présenté ci-dessous : 

 5.4.1 suite 
 
 
 
 
 
 
 
 
Figure 5.4.3 
Icône et commandes de l’outil de 
réglage du niveau de la fenêtre et 
du contraste de l’image 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.4.4 
Exemple d’inversion avec l’outil 
de réglage du contraste et du 
niveau de la fenêtre 
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Réglage dynamique du zoom 
 
L’icône de l’outil de zoom présenté à la Figure 5.4.5 ouvre l’outil de réglage du zoom. Après 
avoir ouvert cet outil, l’utilisateur peut utiliser le curseur pour régler le niveau de zoom, cliquer 
sur le bouton pour Fit to Sample, Fit to Screen ou Zoom 1,0x (Ajuster à la taille de 
l’échantillon, Ajuster à la taille de l’écran ou Zoom 1,0x; pleine résolution) (voir Figure 5.4.6). 
Lorsqu’un zoom a été effectué sur l’image, un panoramique est nécessaire pour naviguer dans 
l’image. Une boîte de dialogue sous forme de vignette apparaîtra dans le coin supérieur gauche 
de l’écran (voir Figure 5.4.7 ci-dessous). Cliquez avec le bouton gauche sur l’image et 
maintenez-le enfoncé, puis déplacez la souris pour déplacer l’image dans l’écran principal. 

Notez que traditionnellement, cette fonction est aussi appelée « Pan View » (Panoramique) 
et/ou « Pan and Scan » (Panoramique et balayage). 

 
 
 
 
 

 
 
 
 
 
 
 
 
Le bouton Fit to Sample (Ajuster à la taille de l’échantillon) tente 
de détecter et d’effectuer un zoom sur l’échantillon pour 
s’assurer qu’il est entièrement visible. Si aucun échantillon n’est 
détecté, il reviendra au mode précédent par défaut, soit « Fit to 
Screen » (Ajuster à la taille de l’écran) ou « Zoom 1.0 x » (Zoom 
x 1,0). 
 
L’option Fit to Screen (Ajuster à la taille de l’écran) ajuste la 
taille de l’image pour s’assurer qu’elle est entièrement visible 
sur l’écran. 
 
Le Zoom 1.0x (Zoom 1,0x) est traditionnellement appelé « Full 
Resolution » (Pleine résolution), car il amène l’image à la taille 
1-1 avec la résolution du moniteur. 
 

 5.4.1 suite 
 
 
 
 
 
 
 
 
 
Figure 5.4.5 
Icône de l’outil de zoom 
 
 
 
Figure 5.4.6 
Outil de réglage du niveau de 
zoom 
 
 
 
Figure 5.4.7 
Exemple panoramique (à gauche) 
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Annotation 

Le bouton présenté à la Figure 5.4.8 ouvre les outils d’annotation. Ces outils et 
leurs nombreuses options sont présentés plus en détail à la Section 5.8.0. 

 

 

Stockage PACS 
Le bouton présenté à la Figure 5.4.9 fonctionne uniquement lorsque le système est 
installé dans un établissement médical disposant d’un réseau PACS. Pour 
enregistrer vos fichiers localement, consultez la Section 5.7.0. 

 

Impression PACS 
Le bouton présenté à la Figure 5.4.10 fonctionne uniquement lorsque le système est 
installé dans un établissement médical disposant d’un réseau PACS. Pour une 
impression locale, consultez la Section 5.7.0. 

 

Panneau de commande du dispositif 
Le bouton présenté à la Figure 5.4.11 ouvre le panneau de commande du dispositif, 
ce qui permet à l’utilisateur du dispositif de contrôler le système de radiologie par 
le biais du logiciel. L’utilisateur peut facilement sélectionner le mode d’exposition, 
les réglages de la tension (kV) du tube à rayons X, la durée d’exposition et le 
nombre d’images à acquérir pour le calcul de la moyenne des images (si désiré), 
puis lancer l’exposition aux rayons X.  

REMARQUE : l’état ou la disponibilité des paramètres 
d’exposition est indiqué par les flèches haut/bas 
situées à côté de chaque paramètre. Les flèches 
sont blanches pour les paramètres actifs et bleu 
clair pour les paramètres inactifs. Les paramètres 
d’exposition actifs dépendent du mode d’exposition 
sélectionné. 

La Figure 5.4.12 à droite montre que le mode « Full 
Auto » (Entièrement automatique) a été sélectionné 
et que la tension (kV), la durée d’exposition et les 
moyennes des images sont tous actifs. L’utilisateur 
peut ajuster chacun de ces paramètres. 
 

Notez que le paramètre mA dans le système 
Faxitron Path ne peut pas être ajusté par le biais 
du logiciel. Par conséquent, le paramètre mA 
s’affiche comme étant inactif. 
 

Lorsque vous avez terminé, cliquez sur le bouton 
Request X-Rays (Demande de radiographie) pour 
acquérir une image ou sur le bouton Set (Définir) 
pour enregistrer les paramètres et fermer le 
panneau de commande du dispositif. 

 

Si vous cliquez sur le bouton Cancel (Annuler), le 
panneau de commande du dispositif se ferme sans 
enregistrer les modifications. 

 5.4.1 suite  
 
Figure 5.4.8 
Icône des annotations  
 
 
  
 
Figure 5.4.9  
Icône de stockage PACS  
 
 
  
 
Figure 5.4.10  
Icône d’impression PACS  
 
 
  
 
 

Figure 5.4.11  
Icône de retour à la procédure 
 
 
 
 
Figure 5.4.12 
Panneau de commande du 
dispositif 
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Retour à la procédure 

Le bouton présenté à la Figure 5.4.13 permet de quitter le mode d’acquisition d’images 
et de revenir à l’écran du menu principal.  

 

Arrêt 
Le bouton présenté à la Figure 5.4.14 permet de quitter le logiciel et d’arrêter le 
système. 
 
 
 

Remarques supplémentaires concernant les boîtes de dialogue 
 
Lorsqu’une boîte de dialogue est ouverte, elle est « ancrée » à gauche de l’écran. Si un 
utilisateur souhaite désancrer la boîte de dialogue, il peut cliquer sur l’icône d’une « épingle » 
en haut à droite pour désancrer la boîte de dialogue et pouvoir la faire glisser librement. Ensuite 
l’icône d’une « épingle » se transforme en l’icône d’un « X » permettant une fermeture rapide. 
 
Les utilisateurs peuvent également naviguer rapidement entre les différentes boîtes de dialogue 
en cliquant sur le menu de gauche. Ainsi, le menu de gauche se ferme rapidement et ouvre les 
boîtes de dialogue appropriées. 

 

Barre de menu supérieure 
Le logiciel permet d’accéder aux menus « View » (Affichage), « Tools » (Outils), « Image tools » 
(Outils d’image), « DICOM Utilities » (Utilitaires DICOM) dans la barre de menu supérieure (voir 
Figure 5.4.15). La barre de menu principal supérieure est masquée par défaut et s’affiche en 
cliquant sur la flèche située dans le coin supérieur droit de l’écran (voir Figure 5.4.16). La 
flèche est noire ou blanche, selon la page du logiciel/l’arrière-plan de l’écran. Chaque élément 
du menu principal est décrit plus en détail dans les pages suivantes. 

 

 

Remarque : la flèche pointe vers le bas lorsque le menu principal est 
masqué et vers le haut lorsqu’il est affiché. 

 

 

Menu View (Affichage) 
Le menu « View » (Affichage) est situé dans la barre de menu supérieure. Il contient les 
éléments de sous-menu présentés à la Figure 5.4.17 ci-dessous. Chaque élément du sous-
menu est décrit en détail dans les pages suivantes. 

 

 

 

 5.4.1 suite 
 
Figure 5.4.13 
Icône de retour au menu d’accueil 
 
 
 
Figure 5.4.14 
Icône d’arrêt du système 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5.4.2  
Barre de menu 
supérieure 
 
 
 
 
 

Figure 5.4.15 
Barre de menu supérieure 
 
Figure 5.4.16 
Boutons de la barre de menu 
supérieure 
 
 
 
5.4.3 
Menu View 
(Affichage) 
 
 
 
Figure 5.4.17 
Menu View (Affichage) 

 



 
 

MANUEL DE L’UTILISATEUR DU FAXITRON PATH | HOLOGIC | RÉVISION 002   

SECTION 
Logiciel VISION 5 

5-17 

 
 
 
 
 

Zoom Mode (Mode zoom) 
 

Normal 
Affiche l’image acquise dans son format original. Dans les systèmes Faxitron Path, l’image 
dépasse la zone d’affichage des moniteurs. Une boîte de dialogue sous forme de vignette sera 
affichée dans le coin supérieur gauche de l’image pour permettre à l’utilisateur de « faire un 
panoramique » en déplaçant l’image. Reportez-vous au Réglage dynamique du zoom à la 
Section 5.4.1.  

 

Adjust Zoom (Régler le zoom) 
Cette option est affichée en gris et n’est pas disponible pour le moment. 

 

Fit to Sample (Ajuster à la taille de l’échantillon) 
Cette option ajuste l’image acquise pour qu’elle corresponde le mieux à l’échantillon dans la 
zone d’affichage du moniteur. 

 

Fit All (Ajuster tout) 
Cette option affiche l’ensemble de l’image acquise, peu importe son format d’origine. L’option 
Full Resolution (Pleine résolution) ne fonctionne pas dans ce mode d’affichage. 

 

Fit Width (Ajuster la largeur) 
Cette option affiche l’image acquise sur toute la largeur disponible de la zone d’affichage. 

 

Fit Height (Ajuster la hauteur) 
Cette option affiche l’image acquise sur toute la hauteur disponible de la zone d’affichage. 

 
Image Averages (Moyennes des images) 

Cette option permet à l’utilisateur de régler le nombre de moyennes d’images à prendre par 
exposition. Les options disponibles sont les suivantes : prises de vue 1x, 2x, 4x ou 8x. Le 
réglage par défaut est une prise de vue 1x. Si l’utilisateur sélectionne 2, 4 ou 8 prises de vue, 
le logiciel acquiert le nombre d’images sélectionné de manière consécutive en appuyant une 
fois sur le bouton Start (Démarrer) et calcule la moyenne de ces images en une seule image. 

 

Image Perspective (Perspective de l’image) 
Cette option permet à l’utilisateur de faire pivoter l’image affichée de 0, 90, 180 et 270 degrés 
pour l’orienter. 

 5.4.3 suite 
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Grid options (Options de grille) 
Lorsqu’une image acquise ou récupérée de la base de données est affichée, l’utilisateur peut 
activer une grille. Elle permet également à l’utilisateur de régler l’espacement (le pas) de la 
grille (voir l’exemple ci-dessous). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

User Window Levels (Niveaux de fenêtre de l’utilisateur) 
Cela permet à l’utilisateur de choisir parmi jusqu’à trois (3) niveaux de fenêtre (WL) prédéfinis. 
Sélectionnez d’abord le bouton Window Level (Niveau de fenêtre) pour choisir le niveau WL 
que vous désirez. Dans les outils « View » (Affichage), sélectionnez « User Window Levels » 
(Niveaux de fenêtre de l’utilisateur). Sélectionnez « Record Current WL as USER WL #1, #2 or 
#3 » (Enregistrer le WL actuel en tant que WL D’UTILISATEUR N°1, N°2 ou N°3). Le WL 
sélectionné sera enregistré sous le choix précédent. 

Default Window Level (Niveau de fenêtre par défaut) 
L’utilisateur dispose de deux choix de  « Default Window Levels » (WL) (Niveau de fenêtre (WL) 
par défaut). L’option « Optimize for whole area » (Optimiser pour la zone entière) ajuste le WL 
de l’image entière, alors que l’option « Optimize for sample » (Optimiser pour l’échantillon) 
ajuste le WL de la zone sous l’échantillon uniquement. De plus, il existe une option permettant 
de définir le « Default Window Level » (Niveau de fenêtre par défaut) pour toutes les images 
obtenues situées au même endroit. Cette action définira le niveau de la fenêtre par défaut en 
fonction des statistiques des images et devra être effectuée séparément pour les images 
rehaussées et non rehaussées. 

Default Aspect of Raw Files (Aspect par défaut des fichiers bruts) 
Cet outil est disponible dans le menu« View » (Affichage). Il permet d’importer/ouvrir des fichiers 
d’images précédemment enregistrés avec des attributs de fichiers inconnus ou des données 
d’images binaires sans aucune information d’en-tête. Étant donné que la taille exacte du tableau 
de l’imageur n’est pas disponible dans l’en-tête du fichier de données d’image, les dimensions de 
l’imageur les plus proches seront utilisées pour importer/ouvrir ces images, en se basant sur le 
fait que la largeur est supérieure ou inférieure à la hauteur (informations sur l’aspect par défaut). 

 

 5.4.3 suite 
 
 
 
 
Figure 5.4.18 
Affichage de grille de l’échantillon 
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Enhance Image (Rehausser l’image; identique au bouton du 
même nom) 

Cet outil traite l’image du patient actuel et rehausse les tissus situés à proximité de la 
périphérie de l’échantillon. 

Sample Viewer (Visionneuse d’échantillons) 
Si le système est muni d’une caméra Web, elle permet de changer l’angle de la caméra Web 
du système pour orienter et aligner l’échantillon. 
 

Review Layout (Mise en page de la révision) 
Permet à l’utilisateur de configurer plusieurs fenêtres d’image en mode « Review » (Révision) 
(base de données) du programme. Les options disponibles pour la mise en page sont « (1 X 1) 
single » (Simple [1 X 1]), « (2 X 1) Double H » (Double H [2 X 1]), « (1 X 2) Double V » 
(Double V [1 X 2]), « (1 + (2 X 1) Triple » (Triple 1 + (2 X 1)] et « (2 X 2) Quadruple » (Quadruple 
[2 X 2]). Lors de l’utilisation de plusieurs fenêtres, l’utilisateur peut cliquer une fois sur la 
fenêtre/l’image souhaitée pour la sélectionner, et sa bordure rectangulaire deviendra verte. 
Dans la vue de la liste des bases de données ou dans la vue des vignettes de la base de 
données, les images seront ouvertes dans la fenêtre sélectionnée en double-cliquant dessus. 
L’utilisateur peut également ouvrir les images dans les fenêtres souhaitées directement à partir 
du menu contextuel des vues de la base de données mentionnées en cliquant sur le bouton de 
droite de la souris. Après avoir activé le menu contextuel, l’utilisateur peut choisir parmi les 
fenêtres énumérées sous OPEN TO (OUVRIR DANS) → qui présentent les fenêtres disponibles 
pour ouvrir l’image (gauche, droite, haut, bas, etc.). 
 

Menu Tools (Outils) 
Le menu « Tools » (Outils) se trouve dans la barre de menu supérieure située dans le coin 
supérieur gauche de l’écran principal. 

 
 

Préférences (Préférences) 
Le menu « Preferences » (Préférences) ouvre un utilitaire de gestion de configuration qui peut 
être utilisé pour modifier plusieurs options ou paramètres. 

REMARQUE : l’option d’outil « Preferences » (Préférences) est protégée par un mot de passe et 
doit être accessible uniquement pour un représentant autorisé du service d’assistance de Hologic. 

REMARQUE : toute modification des paramètres de configuration sans connaissance ou 
autorisation appropriée peut entraîner une perte de la qualité des images, des dommages au 
système et un mauvais fonctionnement du système. 

Service Mode (Mode entretien) 
Le « Service Mode » (Mode entretien) est protégé par un mot de passe et il est activé par les 
techniciens agréés de Hologic à des fins de dépannage. 

 5.4.3 suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5.4.4 
Menu Tools (Outils) 
 
 
Figure 5.4.19 
Menu Tools (Outils) 
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Service Tools (Outils d’entretien) 
Le « Service Tools » (Outils d’entretien) est habituellement affiché en gris. Il est activé 
uniquement lorsque le système est en « Service Mode » (Mode entretien). 

5.4.4 suite 
 

Save Reference Files (Enregistrer les fichiers de référence) 
Le « Save Reference Files » (Enregistrer les fichiers de référence) est habituellement affiché 
en gris. Il est activé uniquement lorsque le système est en « Service Mode » (Mode entretien). 

Option Advanced Tools (Outils avancés) 
Les outils avancés offrent plusieurs options pour configurer certains aspects du logiciel, tels 
que le post-traitement et les options de configuration. 

Auto Save On/Off (Enregistrement automatique Marche/Arrêt) 
Lorsque « Auto Save » (Enregistrement automatique) est « activé », toutes les images 
acquises par la suite sont enregistrées dans la base de données du répertoire de données 
directement défini dans le fichier de configuration. 

X-Ray Calibration/Exposure Set-up (Étalonnage des rayons-
X/Configuration de l’exposition) 

Cet outil est disponible dans Advanced Tools (Outils avancés). La fonction « X-Ray 
Calibration/Exposure Set-up » (Étalonnage des rayons X/Configuration de l’exposition) permet 
à l’utilisateur de déterminer la durée d’exposition appropriée pour un réglage de tension (kV) 
sélectionné, afin d’obtenir une meilleure qualité d’image. Veuillez consulter les Sections 5.2.0 
et 5.2.1 pour une description plus détaillée.  

 

Preshot AEC Exposure Setup (Configuration de l’exposition de la 
pré-image par AEC) 

Le système Faxitron Path utilise le contrôle automatique de l’exposition (AEC) pour fournir la 
meilleure qualité d’image possible en appuyant une seule fois sur le bouton Start X-ray 
(Démarrer les rayons X). Le logiciel utilise une « Preshot » (Pré-image) pour calculer les valeurs 
optimales de la tension (kV) et de la durée d’exposition. La « Preshot » (Pré-image) est une 
exposition aux rayons X de courte durée, habituellement de 2 à 3 secondes. Le logiciel analyse 
les résultats pour déterminer la tension (kV) et le temps nécessaires pour produire la meilleure 
qualité d’image. La « Preshot AEC Exposure » (Exposition de la pré-image par AEC) est 
configurée pendant la fabrication du système et activée par défaut. 

La « Preshot AEC Exposure Setup » (Configuration de l’exposition de la pré-image par AEC) 
permet à l’utilisateur d’ajuster le système aux besoins particuliers d’un examen d’imagerie ou 
pour compenser le vieillissement du système. 

Pour accéder à la boîte de dialogue de « Preshot AEC Exposure Setup » (Configuration de 
l’exposition de la pré-image par AEC) à partir de la barre de menu supérieure, sélectionnez 
« Tools » (Outils), « Advanced Tools » (Outils avancés) et « Preshot AEC Exposure Setup » 
(Configuration de l’exposition de la pré-image par AEC) (voir Figure 5.4.19). 
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Saisissez les valeurs d’AEC pour la 
pré-image dans la fenêtre affichée à 
droite. 
 
Les paramètres indiqués pour le 
réglage de la pré-image comprennent 
une tension de 26 kV, une durée 
d’exposition de 3 secondes et une 
intensité cible de 10 000 ADU. Les 
utilisateurs peuvent accéder à la 
sélection des paramètres de la pré-
image uniquement en sélectionnant 
« DYNAMIC METHOD » (MÉTHODE 
DYNAMIQUE) dans la section 
« ANALYSIS METHOD » (MÉTHODE 
D’ANALYSE). La sélection de 
« STATIC METHOD » (MÉTHODE 
STATIQUE) utilise les paramètres 
prédéfinis du Faxitron. De plus, 
l’utilisateur a la possibilité de 
sélectionner les paramètres de 
tension (kV) et de durée d’exposition 
dans la section « EXPOSURE 
TUNING METHOD » (MÉTHODE 
D’AJUSTEMENT DE 
L’EXPOSITION). 
 
Pour obtenir des images plus 
précises, l’utilisateur peut saisir 
l’épaisseur de « SOFT TISSUE » 
(TISSU MOU; échantillon) et 
TARGET INTENSITY (INTENSITÉ CIBLE) en ADU. REMARQUE : Les valeurs indiquées dans 
l’image ci-dessus sont uniquement un exemple. La valeur correcte doit être déterminée. 
 
Remarque : les valeurs indiquées dans l’image ci-dessus sont typiques pour un système 
Faxitron Path. Les valeurs exactes pour votre système doivent être déterminées. 
 
Pour le mode « AUTOMATIC EXPOSURE CONTROL » (COMMANDE D’EXPOSITION 
AUTOMATIQUE), appuyez sur le bouton Start (Démarrer) du logiciel Vision. Le logiciel Vision 
capture une pré-image (pré-exposition courte et faible) de l’échantillon pour créer une région 
d’intérêt (RI), afin de définir les paramètres d’exposition optimale de l’image. 
 

Login Utility (Utilitaire de connexion) 
 
Le « Login Utility » (Utilitaire de connexion) est disponible dans le menu ADVANCED TOOLS 
(OUTILS AVANCÉS). Il permet à l’utilisateur de configurer et d’activer l’authentification par mot 
de passe au démarrage du logiciel Vision. L’activation de cette fonctionnalité est facultative sur 
le système Faxitron Path. Si l’utilisateur 
active l’authentification par mot de 
passe, il sera invité à saisir son mot de 
passe à chaque ouverture du 
programme. Le programme se ferme si 
le mot de passe saisi est incorrect. 

 

 

 

 5.4.4 suite 
 
Figure 5.4.20 
Boîte de dialogue Preshot AEC 
Exposure Setup (Configuration de 
l’exposition de la pré-image par 
AEC) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.4.21 
Utilitaire de connexion Le 
même écran apparaîtra lors 
de l’authentification au 
démarrage. 
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Properties (Propriétés) 
L’option « Properties » (Propriétés) masque ou affiche la boîte de dialogue d’informations sur 
l’image (voir Figure 5.3.9). 
 
Edit Current Image Record (Modifier l’enregistrement de l’image 

actuelle) 
Actuellement non utilisé. 
 

Delete Current Image Record (Supprimer l’enregistrement de 
l’image actuelle) 

Supprime l’image actuelle du répertoire de fichiers tel que spécifié dans le fichier de configuration. 
 

Add Current Image Record (Ajouter l’enregistrement de l’image 
actuelle) 

Ajoute l’image actuelle au répertoire de fichiers tel que spécifié dans le fichier de configuration. 
 
Capture Screen Shot JPG/BMP (Capture d’écran en format JPG/BMP) 
En sélectionnant cette option de menu, l’utilisateur peut effectuer une capture d’écran de la 
fenêtre active affichée. L’utilisateur peut spécifier un nom de fichier et choisir d’enregistrer le 
fichier en format JPG ou BMP. 
 

Save/Store Current Image (Enregistrer/stocker l’image actuelle) 
L’utilisateur peut « naviguer » jusqu’au répertoire ou au dossier de fichiers dans lequel l’image 
doit être enregistrée. Un nom de fichier doit être attribué dans le champ prévu à cet effet. 
Sélectionnez un type de fichier sous lequel enregistrer l’image. De nombreux types de fichiers 
sont disponibles. Pour enregistrer le fichier en format DICOM, consultez la 
section « Fonctionnalité DICOM ». 

Print Current Image (Imprimer l’image actuelle) 
Imprime l’image actuelle sur l’imprimante WINDOWS. 
 

Outils d’image 
Les fonctions suivantes sont disponibles pour modifier l’image acquise ou récupérée en 
cliquant sur le menu « Image tools » (Outils d’image) (voir Figure 5.4.22). Les options du 
sous-menu sont activées ou accessibles d’un simple clic 
sur l’option souhaitée. 

 

 

 

 

 

 5.4.4 suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5.4.5 
Outils d’image 
 
 

Figure 5.4.22 
Menu « Image tools » (Outils 
d’image) 
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Original Contrast (Contraste d’origine) 
L’option « Original Contrast » (Contraste d’origine) rétablit les niveaux de contraste de l’image. 
Cette fonction est identique à celle du bouton Original Contrast (Contraste d’origine) de l’outil 
« Contraste et niveau de la fenêtre » (voir Section 5.4.1 et Figure 5.4.3). 

Invert (Inverser) 
L’option « Invert » (Inverser) permet l’inversion de l’image affichée. L’inversion d’une image 
inverse sa transparence : ce qui est noir devient blanc et ce qui est blanc devient noir. Les gris 
se voient attribuer leur transparence miroir. Cliquez à nouveau sur « Invert » (Inverser) pour 
désactiver la fonctionnalité. Cette option possède la même fonction que le bouton Invert 
(Inverser) (voir Section 5.4.1 et Figures 5.4.3 et 5.4.4). 

Agrandir 
L’option « Magnify » (Agrandir) permet à l’utilisateur d’agrandir une zone d’intérêt. Pour utiliser 
la fonctionnalité « Magnify » (Agrandir), placez le curseur de la souris sur la zone à agrandir et 
cliquez avec le bouton gauche de la souris. La région d’intérêt sera agrandie. Cliquez à nouveau 
sur « Magnify » (Agrandir) pour désactiver la fonctionnalité (voir Figure 5.4.23). La taille de la 
région d’intérêt agrandie peut être ajustée par l’utilisateur. Consultez le sous-menu « Magnifier 
Size » (Taille de la loupe) à la Section 5.4.3. 

 

 

 

 

 

 

 

 
 
 
 

Edge Enhance (Rehaussement des contours) 
L’outil « Edge Enhance » (Rehaussement des contours) produit une définition plus nette des 
contours des régions présentant une différence de contraste. D’une manière générale, le 
rehaussement des contours peut amplifier le bruit des images. En sélectionnant à nouveau cet 
outil dans le menu, vous désactivez le rehaussement des contours. La sélection du bouton 
« Original Contrast » (Contraste d’origine) permet également de rétablir l’image dans son état 
d’origine. Notez qu’il s’agit d’une fonctionnalité différente de la fonctionnalité « Enhance 
Image » (Rehausser l’image) des Sections 5.4.1 et 5.4.3. 

ROI Contrast (Contraste de la RI) 
L’outil « ROI Contrast » (Contraste de la RI) permet d’optimiser les niveaux de contraste dans 
une région d’intérêt (RI) définie par l’utilisateur. Après avoir sélectionné « ROI Contrast » 
(Contraste de la RI), cliquez et maintenez le bouton gauche de la souris enfoncé au point de 
départ de la RI désirée, faites glisser la souris et relâchez le bouton de la souris au point final 
de la RI désirée. Le contraste se règle automatiquement sur les meilleurs niveaux pour cette 
RI (voir la Section des définitions pour la RI). 

ROI Window Level (Niveau de fenêtre de la RI) 
L’outil « ROI Window Level » (Niveau de fenêtre de la RI) n’est pas disponible dans la version 
actuelle du logiciel Vision. 

 5.4.5 suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.4.23 
Agrandir 
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Règle 
L’outil « Ruler » (Règle) permet à l’utilisateur de mesurer la distance entre deux points dans 
l’image affichée. Les mesures de longueur sont en millimètres (mm). Après avoir sélectionné 
« Ruler » (Règle), cliquez et maintenez le bouton gauche de la souris enfoncé au point de 
départ de la mesure, faites glisser la souris et relâchez le bouton de la souris au point de la fin 
de la mesure. La règle s’affiche sous la forme d’une ligne rouge sur l’image. 
 
La mesure (en mm) est affichée à 
l’extrémité de la règle. La règle 
demeure active jusqu’à ce que 
l’utilisateur sélectionne un autre 
outil d’image ou jusqu’à ce qu’une 
autre action soit effectuée (voir 
Figure 5.4.24 à droite). Cliquez à 
nouveau sur « Ruler » (Règle) 
pour désactiver la fonctionnalité. 
 
Astuce : pour obtenir une ligne 
parfaitement droite, ou une ligne à 
un angle parfait de 45 degrés, 
maintenez la touche MAJ (sur le 
clavier) enfoncée tout en maintenant 
le bouton gauche de la souris 
enfoncé, et faites glisser la souris. 
 

 
Statistiques de la RI 

L’outil « ROI Statistics » (Statistiques de la RI) affiche une boîte de dialogue contenant les 
statistiques de l’image. Cliquez et maintenez le bouton gauche de la souris enfoncé sur la région 
d’intérêt (RI) de l’image principale, faites glisser le curseur de la souris autour de la région que 
vous souhaitez sélectionner, puis relâchez le bouton de la souris. Les informations statistiques 
s’affichent du côté gauche de la boîte de dialogue pour la région sélectionnée et du côté droit 
de la boîte de dialogue pour l’image entière. Les statistiques affichées sont les suivantes : les 
points du début et de la fin de la RI, les valeurs d’intensité minimale, maximale et moyenne et 
l’écart-type (ET). Pour fermer la boîte d’informations statistiques, cliquez sur le bouton Close 
(Fermer) (voir Figure 5.4.25). Cliquez à nouveau sur « ROI Statistics » (Statistiques de la RI) 
pour désactiver la fonctionnalité. 
 
 
 

 5.4.5 suite 
 
 
 
 
 
 
Figure 5.4.24 
Règle 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.4.25 
Statistiques de la RI 
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Histogramme de la RI 
L’outil « ROI Histogram » (Histogramme de la RI) crée un histogramme pour la RI définie par 
l’utilisateur. Après avoir sélectionné cet outil dans le menu, placez le curseur de la souris dans 
l’image affichée, appuyez sur le bouton gauche de la souris et maintenez-le enfoncé, puis faites 
glisser le curseur pour sélectionner la RI souhaitée. Relâchez le bouton de la souris. 
L’histogramme de la RI sélectionnée est affiché (voir Figure 5.4.6). 

La courbe noire est l’histogramme de la région sélectionnée. La courbe bleue est l’histogramme 
de l’image entière. Les deux courbes sont normalisées par rapport à la valeur maximale de pixel 
de la région d’intérêt sélectionnée. Cliquez à nouveau sur « ROI Histogram » (Histogramme de la 
RI) pour désactiver la fonctionnalité. 

 

 

 

 

 

 

 

 

 

 

 

Profil de la RI 
L’outil « ROI Profile » (Profil de la RI) crée un profil pour la RI définie par l’utilisateur. Après 
avoir sélectionné cet outil dans le menu, placez le curseur dans l’image affichée. Maintenez le 
bouton gauche de la souris enfoncé et déplacez le curseur sur l’image pour dessiner un cadre 
défini par l’utilisateur autour de la RI souhaitée. Relâchez le bouton gauche de la souris et un 
profil de la valeur de chaque pixel de la RI définie est affiché (voir Figure 5.4.27). Par défaut, 
les valeurs moyennes de la RI sélectionnée sont calculées sur l’axe court. L’axe peut être 
changé en sélectionnant le bouton « SWITCH, HOR<->VERT » (BASCULER, HOR<->VERT). 
Cliquez à nouveau sur « ROI Profile » (Profil de la RI) pour désactiver la fonctionnalité. 

 

 5.4.5 suite 
 
 
 
 
 
 
 
 
 
 
Figure 5.4.26 
Histogramme de la RI 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.4.27 
Profil de la RI 
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Profil de ligne 
L’outil « Line Profile » (Profil de ligne) affiche un profil pour une ligne définie par l’utilisateur. 
Après avoir sélectionné « Line Profile » (Profil de ligne), placez le curseur dans l’image affichée. 
Maintenez le bouton gauche de la souris enfoncé et déplacez le curseur sur l’image pour tracer 
une ligne définie par l’utilisateur. Relâchez le bouton gauche de la souris pour afficher un profil 
indiquant la valeur de chaque pixel de la ligne définie (voir Figure 5.4.28). Par défaut, le premier 
point sélectionné est toujours la partie la plus à gauche (près de l’origine) du graphique (c’est-
à-dire que l’axe horizontal du graphique peut avoir des indices de pixels (i,i) croissants ou 
décroissants, selon les points de départ/fin sélectionnés). Cliquez à nouveau sur « Line 
Profile » (Profil de ligne) pour désactiver la fonctionnalité. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Niveau de fenêtre intégré 
Le logiciel Vision est livré avec une fonction de niveau de fenêtre « intégré ». Il n’y a aucun 
bouton ou élément de menu pour la sélectionner. La fonctionnalité « Window Level » (Niveau 
de fenêtre) est activée automatiquement chaque fois qu’une image est acquise ou récupérée 
de la base de données pour l’examiner. Cette fonctionnalité permet à l’utilisateur de régler les 
niveaux de contraste et de luminosité de l’image à l’aide du curseur de la souris. 

Cliquez et maintenez le bouton gauche de la souris enfoncé sur l’image affichée et déplacez le 
curseur vers le haut et le bas pour obtenir les niveaux de luminosité/d’obscurité ou vers la 
gauche et la droite pour obtenir les niveaux de contraste faible/élevé. Déplacez le curseur 
jusqu’à ce que l’image atteigne les niveaux souhaités. 

 

 5.4.5 suite 
 
 
 
 
 
 
 
 
 
Figure 5.4.28 
Profil de ligne 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 



 
 

MANUEL DE L’UTILISATEUR DU FAXITRON PATH | HOLOGIC | RÉVISION 002   

SECTION 
Logiciel VISION 5 

5-27 

En appuyant sur le bouton situé en bas de la fenêtre d’acquisition d’images (voir Figure 5.5.1), 
la bande des vignettes d’images du patient actuel apparaît (voir Figure 5.5.2). 
 
 
 
 
 
 

 
 
 
 
La bande de vignettes affiche la date de la procédure pour chaque série d’images en texte 
orange dans la partie supérieure. 

L’image actuelle affichée dans la fenêtre d’acquisition d’images est surlignée en vert. 

La bande des vignettes est compatible avec les opérations de glisser-déposer pour placer les 
images dans la zone d’affichage des images ou dans les fenêtres de révision, selon les besoins. 

De plus, l’utilisateur peut sélectionner plusieurs images d’un simple clic, puis choisir parmi 
différentes options pour enregistrer les images sur une clé USB, envoyer les images au PACS 
ou supprimer les images. Les images sélectionnées sont surlignées en orange. 

Des flèches sont affichées à gauche et à droite de l’écran. Si plusieurs images sont prises, 
l’utilisateur peut parcourir les images par date croissante en appuyant sur les flèches 
gauche/droite.  

De plus, l’option Open the Database (Ouvrir la base de données) (voir figure 5.5.3) permet de 
passer en mode Révision. Ce bouton équivaut à appuyer sur Review Mode (Mode Révision) 
dans le Menu d’accueil (voir Figures 5.0.1 et 5.6.1). 

 
 
Le mode Révision peut être activé en cliquant sur le bouton « Review » dans le menu d’accueil 
(voir Figures 5.6.1 et 5.0.1) ou sur le bouton Open Database (Ouvrir la base de données) du 
navigateur pour les images du patient actuel (voir Figure 5.5.3). Cliquez sur 
l’un de ces boutons pour ouvrir la base de données (voir Figure 5.6.2). Le 
système est en veille en mode de révision. 
 
 
 
 
 
La base de données comprend essentiellement trois sections ou sous-fenêtres : la section 
« Patient List Table » (Tableau de la liste des patients) à gauche, la section « Procedure List 
Table » (Tableau de la liste des procédures) en haut à droite et la section « Image Thumbnail 
List/Viewer » (Liste/Visionneuse des vignettes d’images) en bas à droite. 

 

 5.5.0 
Navigateur des 
images du patient 
actuel 
Figure 5.5.1 
Icône du navigateur pour les 
images du patient actuel 
 
Figure 5.5.2 
Navigateur des images du patient 
actuel 
 
Figure 5.5.3 
Bouton Image Database (Base de 
données d’images) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5.6.0 
Base de données 
 
Figure 5.6.1 
Icône du mode de révision 
affichée dans le menu d’accueil. 
 
 
 
 
 
 
 
Figure 5.6.2 
Base de données d’images 
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Les tableaux des listes fonctionnent selon une hiérarchie descendante, comme indiqué par la 
flèche : 

Liste des patients --->Liste des procédures --->Liste/visionneuse des vignettes d’images. 

La fenêtre « Patient selection » (Sélection du patient) est la fenêtre supérieure gauche. La 
fenêtre « Procedure » (Procédure) est la fenêtre supérieure droite. 

Lorsqu’un champ Patient est sélectionné, la fenêtre « Procedure » devient active. La fenêtre 
« Procedure » (Procédure) affiche la liste de toutes les procédures effectuées pour le patient 
sélectionné. De plus, toutes les images du patient sont affichées en bas à droite. Il n’est pas 
possible de sélectionner plusieurs patients. 

Lorsqu’une procédure est sélectionnée, la liste/visionneuse des vignettes est filtrée pour 
afficher uniquement les images correspondant à la procédure sélectionnée. Plusieurs 
procédures peuvent être sélectionnées en maintenant la touche Maj enfoncée et en cliquant 
avec le bouton gauche de la souris sur chaque procédure. Toutes les images des procédures 
sélectionnées seront affichées. 

• Le tri de la base de données peut être réglé en cliquant sur les champs supérieurs, tels que 
l’ID du patient et le nom de famille, pour trier selon l’un ou l’autre des critères. Lorsque vous 
cliquez sur l’un des champs de la base de données avec le curseur de la souris, une petite 
flèche s’affiche dans le champ. En utilisant le bouton de gauche de la souris et en 
sélectionnant le champ à nouveau, le dessin de la flèche passe d’ascendant à descendant 
ou inversement. Le champ sélectionné sera automatiquement trié en conséquence. 

• La base de données affiche des barres de défilement pour faciliter la navigation. 

• La liste/visionneuse des vignettes d’images permet à un utilisateur de cliquer sur le symbole 
« + » pour ajouter automatiquement l’image à une fenêtre de révision. Un utilisateur peut 
ajouter jusqu’à quatre images dans les fenêtres de révision. Les fenêtres de révision sont 
ajustées automatiquement pour englober les quatre images. 

• Les mêmes options que celles disponibles dans le navigateur d’images des patients actuels 
(voir figure 5.5.2) se trouvent également en haut de la base de données. Toutefois, d’autres 
options sont également disponibles, et elles sont décrites à la Section 5.5.2. 

Remarques importantes : les vignettes des images (.PNG) sont des fichiers distincts des 
fichiers de données d’images réelles (DCM, DAT, DMM, RAW). Elles portent le même nom de 
fichier que le fichier d’image, mais leur extension de fichier est différente (.PNG). Il est possible 
d’avoir un fichier d’images sans « vignette ». Dans ce cas, le logiciel Vision tentera de créer 
automatiquement une vignette pour que l’image soit chargée dans la base de données. 
Cependant, si cette opération échoue, l’image ne sera pas affichée. 

 

Save Image(s) (Enregistrer la/les image(s)) 
Le bouton Save image(s) (Enregistrer la/les image(s)) devient disponible lorsqu’une entrée du 
tableau des images ou de la liste des vignettes est sélectionnée, ou qu’une image du patient 
est sélectionnée, sinon il est désactivé. L’image sélectionnée peut être enregistrée dans les 
formats 8 bits courants suivants : JPEG, BMP, TIFF ET RAW. Elle peut également être 
enregistrée en format TIFF de 16 bits. 

Le niveau de fenêtre de l’image enregistrée est le niveau de fenêtre par défaut. Si l’utilisateur 
souhaite que le niveau de fenêtre soit modifié, il doit charger l’image dans « Image View » (Vue 
d’image) et l’imprimer à partir de cet emplacement, plutôt que de l’imprimer à partir de la boîte 
de dialogue de la base de données. 

 

Send Image(s) to PACS (Envoyer une/des image(s) au PACS) 
Cette fonctionnalité envoie une ou des images à un serveur DICOM PACS préconfiguré. 
Veuillez consulter la Section 5.7.0 pour obtenir plus d’informations. 

 

 5.6.0 suite 
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Fonctions et outils du menu de la base de données d’images 
Il existe des fonctions permettant de naviguer et d’effectuer 
des recherches dans la base de données, ainsi que de 
modifier, supprimer et ajouter des enregistrements à la base 
de données. Ces fonctions sont décrites dans les options de 
menu de la base de données. Ils sont accessibles à partir du 
bouton du haut intitulé Additional Options (Options 
supplémentaires) dans la base de données. 

 

 

 

Menu Open (Ouvrir) 
Le menu « Open » (Ouvrir) affiche uniquement l’option « Open Image from File » (Ouvrir une 
image à partir d’un fichier). Elle ouvre une boîte de dialogue de Windows qui permet à l’utilisateur 
de naviguer vers les lecteurs locaux ou d’un réseau pour ouvrir des fichiers d’images. 

Menu Print (Imprimer) 
Le menu « DB-PRINT » (IMPRIMER LA BD) offre des fonctionnalités d’impression par image, 
par procédure et par patient (voir Figure 4.6.4). 

 

 

 

Print Image to Local Printer (Imprimer l’image sur une imprimante 
locale) 

L’option « Print Image to Local Printer » (Imprimer l’image sur une imprimante locale) devient 
disponible lorsqu’une entrée du tableau des images ou de la liste des vignettes est 
sélectionnée, sinon elle est désactivée. L’image sélectionnée sera imprimée avec l’imprimante 
locale par défaut du système Windows. 

Le niveau de fenêtre de l’image imprimée est le niveau de fenêtre par défaut. Il n’est pas 
recommandé aux utilisateurs d’imprimer à partir de ce menu, à moins qu’ils ne soient satisfaits 
des impressions définies sur les niveaux de fenêtre par défaut calculés par le programme. 
L’utilisateur peut d’abord charger l’image dans la fenêtre « Image View » (Vue d’image) 
(Révision) pour pouvoir régler l’image aux niveaux de fenêtre souhaités. Lorsqu’il est satisfait 
du niveau de la fenêtre, l’utilisateur peut alors lancer l’impression à partir du menu de la fenêtre 
Image View (Vue d’image). Une boîte de dialogue « Format Options » (Options de formats) 
permet de choisir le format d’impression. 

Print Image(s) to DCM Printer (Imprimer la/les images sur une 
imprimante DCM) 

Cette fonction envoie la/les images à une imprimante DICOM préconfigurée. 

Menu View (Affichage) 
Le menu « View » (Affichage) offre à l’utilisateur un certain nombre d’options pour l’affichage 
de la base de données (voir Figure 5.6.5). 
 
 
 
 
 
 

 5.6.1 
Options 
supplémentaires 
de la base de 
données 
 
Figure 5.6.3 
Menu Additional Options (Options 
supplémentaires) 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.6.4 
Menu Print (imprimer) de la base 
de données 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.6.5 
Menu View (Affichage) de la base 
de données 
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Show All DB Entries (Afficher toutes les entrées de la BD) 
Recharge le tableau de la liste des patients à partir du fichier de la base de données. Tout 
nouveau changement ou ajout à la base de données sera appliqué au tableau. Cette sélection 
efface également tout « Search Filter » (Filtre de recherche) actif qui aurait pu être appliqué au 
tableau. L’outil « Search Filter » (Filtre de recherche) est expliqué en détail dans la section 
Recherche dans la base de données ci-dessous. 

Refresh DB Entries (Actualiser les entrées de la BD) 
Actualise le tableau de la liste des patients, mais conserve tout « Search Filter » (Filtre de 
recherche) existant qui a été appliqué. 

Browse Data Directory (No DB) (Parcourir le répertoire de 
données - aucune BD) 

Affiche toutes les vignettes d’images dans le répertoire des données établi par le fichier de 
configuration. Ces fichiers sont affichés dans la visionneuse de vignettes. Ils ne sont associés 
ni à la base de données, ni aux listes de tableaux. Cet outil est utile pour examiner les images 
non enregistrées ou pour résoudre les problèmes de base de données lorsque des images sont 
présentes dans le répertoire de données actuel. 

Browse Any Directory (No DB) (Parcourir n’importe quel 
répertoire - aucune BD) 

Permet à l’utilisateur de naviguer dans n’importe quel répertoire de fichiers. Ces fichiers sont affichés 
dans la visionneuse de vignettes. Ils ne sont associés ni à la base de données, ni aux listes de 
tableaux. Cet outil est utile pour examiner un répertoire d’images qui n’a jamais été enregistré dans 
la base de données ou lorsque les enregistrements de la base de données sont corrompus. 

Menu Search (Rechercher) 
L’outil « Search » (Recherche) dans le base de données (voir Figure 5.6.6) permet d’effectuer 
des recherches détaillées ou de filtrer la base de données. En sélectionnant le menu « DB-
Search » (Recherche dans la BD), une recherche détaillée et spécifique peut être effectuée. 
Lorsqu’un critère de recherche est saisi et activé dans la boîte de dialogue « DB-Search » 
(Recherche dans la BD; voir Figure 5.6.7), le filtre de recherche est appliqué à tous les tableaux 
de listes de la boîte de dialogue « Image Database » (Base de données d’images). Le critère 
de recherche activé est appelé « Search filter » (Filtre de recherche) et ce filtre demeure actif 
jusqu’à ce que l’utilisateur sélectionne « Stop search » (Arrêter la recherche) dans le menu 
« DB-Search » (Recherche dans la BD) ou « Show All DB Entries » (Afficher toutes les entrées 
de la BD) dans le menu « DB-View » (Vue de la BD). La fonctionnalité « Search filter » (Filtre 
de recherche) actif est toujours 
affiché dans la légende de la boîte 
de dialogue « Image Database » 
(Base de données d’images). 
 

Start search (Démarrer la recherche) 
La fonctionnalité « Start search » (Démarrer la recherche) ouvre la boîte de dialogue « DB-
Search » (Recherche dans la BD) qui permet à l’utilisateur de placer un filtre de recherche actif 
dans la base de données. Lorsque la boîte de dialogue « Search » (Recherche) est ouverte, la page 
« Database » (Base de données) se ferme et le logiciel revient à la page « Image Acquisition » 
(Acquisition d’images). 
La page « Database » 
(Base de données) 
s’ouvre 
automatiquement après 
la fermeture de la boîte 
de dialogue « Search » 
(Recherche). 

 5.6.1 suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.6.6 
Menu Database Search 
(Recherche dans la base de 
données) 
 
 
 
 
 
 
Figure 5.6.7 
Lancement d’une recherche dans 
la base de données 
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Les menus déroulants proposent des listes de catégories de recherche. Sélectionnez une 
catégorie de recherche et saisissez le paramètre de recherche souhaité pour lancer la 
recherche. Sélectionnez « Start » (Démarrer) pour lancer la recherche. Si une catégorie 
contient plus d’une entrée distincte, alors toutes les entrées de cette catégorie seront affichées.  
 

5.6.1 suite 
 

Stop Search (Arrêter la recherche) 
L’option « Stop Search » (Arrêter la recherche) désactive tous les filtres de recherche actifs, 
efface tous les tableaux de listes et recharge la liste de tous les patients dans le tableau de la 
liste des patients. 

Menu Tools (Outils) 
Le menu « DB-Tools » (Outils de la BD) propose des fonctions par image, par procédure, par 
patient, ainsi que des fonctions utiles pour réparer ou reformater la base de données. 

 

 

 

 

 

Edit Image Record (Modifier un enregistrement d’image) 
La fonction « Edit Image Record » (Modifier un enregistrement d’image) n’est actuellement pas 
disponible dans le logiciel Vision. 

ADD Record to DB (AJOUTER un enregistrement à la BD) 
Disponible lorsque l’entrée à partir du Tableau des images ou de la Liste des vignettes est 
sélectionnée, sinon cette fonction est désactivée. Ceci est particulièrement utile lorsqu’un 
répertoire est parcouru alors que la base de données ne dispose d’aucune saisie pour les 
images dans ce répertoire. L’utilisateur peut sélectionner une seule image dans la liste des 
vignettes et ajouter des enregistrements de cette image dans la base de données. Si la saisie 
existe déjà dans la base de données pour l’image sélectionnée, elle ne représente aucun 
danger, car elle peut uniquement mettre à jour son l’emplacement actuel du fichier d’images 
dans la base de données, c’est-à-dire le nom du fichier/dossier. 

Import Records in DIR to DB (Importer des enregistrements du 
RÉP vers la BD) 

Cet outil permet de parcourir et de sélectionner un dossier, puis de remplir la base de données 
avec toutes les saisies correspondantes pour tous les fichiers d’images dans le répertoire 
sélectionné (y compris les sous-répertoires). Les formats d’images peuvent être DCM, DAT, 
DMM et RAW. Si des vignettes ou des images sont manquantes, cet outil génère également 
des vignettes en format BMP dans le même répertoire. 

Reformat All DB (Reformater toute la base de données) 
L’outil « Reformat All DB » (Reformater toute la base de données)  permet de reformater les 
champs des tableaux « Date » (Date) [AAAA/MM/JJ] et « Date/Time » (Date/Heure) 
[AAAA/MM/JJ HH:MM:SS], et de mettre en majuscules les lettres des saisies de certains autres 
champs. Cet outil est utile lorsqu’un fichier de base de données plus ancien est importé et 
ouvert pour la première fois, ou lorsque l’utilisateur modifie manuellement les saisies de la base 
de données à l’aide de MS Access. 

 

  
 
 
 
 
 
 
 
 
 
Figure 5.6.8 
Menu des outils de la base de 
données 
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Remarques supplémentaires sur la base de données 
• La possibilité de quitter la base de données, en restant en mode Review (Révision), se trouve 

dans Additional Options (Options supplémentaires). 

• Le bouton en haut à gauche se règle automatiquement pour ramener l’utilisateur à 
l’acquisition ou au menu principal, ou il devient le bouton Close Database (Fermer la base 
de données), en fonction du flux de travail utilisé pour accéder à l’écran « Database » (Base 
de données) ou l’écran le plus approprié. 

 

odifier ou supprimer les informations sur le patient dans la base 
de données 

L’utilisateur peut modifier ou supprimer des informations sur le patient dans la base de données. 
Cliquez avec le bouton droit de la souris sur l’entrée du patient au haut de la base de données 
pour ouvrir une boîte de dialogue (voir Figure 5.6.9). 

 

 

Cliquez sur « Edit Patient Information » (Modifier 
les informations sur le patient) pour ouvrir la boîte 
de dialogue « Patient Information » (Informations 
sur le patient) (voir Figure 5.6.10). Cliquez sur 
Cancel (Annuler) pour revenir à la base de 
données sans effectuer ni enregistrer des modifications. Cliquez sur Save Changes 
(Enregistrer les modifications) pour ouvrir la boîte de dialogue « Confirmation » (Confirmation). 
Cliquez sur Yes (Oui) pour confirmer et continuer. Les modifications sont maintenant 
enregistrées et l’utilisateur est ramené à la base de données. Cliquez sur No (Non) pour annuler 
les modifications et retourner à la base de données. Cliquez sur Cancel (Annuler) pour ramener 
la boîte de dialogue « Patient Information » (Informations sur le patient). 

Remarque : si le système possède un mot de passe de démarrage activé (voir la description 
de l’utilitaire de connexion à la Section 5.4.4 et la figure 5.4.21), le même mot de passe sera 
demandé lors de la tentative de « Delete Patient Information » (Suppression des informations 
sur le patient) de la base de données. 

 

La norme DICOM 
Qu’est-ce que la norme DICOM? 

La norme DICOM (Digital Imaging and Communications in Medicine) est une série de 
protocoles utilisés par les équipements et logiciels médicaux pour permettre aux données d’être 
compatibles et interchangeables avec d’autres équipements ou logiciels médicaux. 

Lorsqu’un fichier est enregistré dans un format DICOM, un fichier est créé. Celui-ci comprend 
les données pertinentes du patient, les données de l’équipement d’imagerie et du matériel ainsi 
que les données d’image, le tout dans un seul fichier. De plus, le fichier enregistré contient des 
caractéristiques spécifiques qui permettent à l’ordinateur et au logiciel de l’identifier comme 
étant un fichier conforme à la norme DICOM. Une fois qu’une application logicielle reconnaît le 
fichier comme un fichier conforme à la norme DICOM, elle peut lancer un lecteur DICOM et 
extraire les données correctement, quelle que soit l’origine du fichier.  

Un fichier créé avec le protocole DICOM a la structure suivante.  

 5.6.1 suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.6.9 
Boîte de dialogue Edit/Delete 
(Modifier/Supprimer) (gauche) 
 
Figure 5.6.10 
Patient Information (Informations 
sur le patient) (droite) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5.7.0 
Fonctionnalité 
DICOM 
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Lorsque le préambule comprend 128 octets, ils sont 
habituellement tous définis sur 00H, sauf s’il n’est pas utilisé par 
un profil d’application ou une implémentation spécifique. Le 
préfixe comprend 4 octets constituant la chaîne de caractères 
« DICM » encodée en lettres majuscules du répertoire de 
caractères ISO 8859 G0. Les éléments de données sont 
arbitrairement grands (ou petits) et contiennent les données. 
 

Modalité 
Les paramètres d’un fichier DICOM pour la « Modality » (Modalité) sont accessibles à partir de 
la barre de menu supérieure en sélectionnant « DICOM Utilities » (Utilitaires DICOM), puis 
« DICOM Modality Setup » (Configuration de modalité DICOM). 

 

 

 

Le type de stockage DICOM, « Presentation » (Présentation) ou « Processing » (Traitement), 
peut être sélectionné. La même boîte de dialogue permet de sélectionner la modalité d’image 
DICOM, soit radiographie numérique ou mammographie numérique. Les paramètres 
« Transfer Syntax » 
(Syntaxe de transfert) et 
« Value Representation » 
(Représentation de la 
valeur) ne peuvent pas 
être définis par 
l’utilisateur. Ils sont 
toujours réglés sur META 
HEADER PRESENT, 
LITTLE_ENDIAN et 
VR_IMPLICIT. 

 

 Figure 5.7.1 
Structure du protocole DICOM 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.7.2 
Menu DICOM Utilities (Utilitaires 
DICOM) 
 
 
 
 

Figure 5.7.3 
Paramètres de modalité DICOM  
Paramètres par défaut affichés 
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REMARQUE : une fois les modalités DICOM sélectionnées, elles demeurent actives, même 
après la fermeture du logiciel Vision. Les paramètres de modalité sont stockés et resteront 
configurés jusqu’à ce qu’ils soient modifiés à nouveau à l’aide des paramètres de fichier 
DICOM. Ces paramètres (type et modalité de stockage, syntaxe de transfert et représentation 
de la valeur) seront effectifs pour toutes les fonctionnalités DICOM d’enregistrement et 
d’impression locale. 

Default DICOM Servers (Serveurs DICOM par défaut) 
Cette section contient les paramètres par défaut des serveurs DICOM et permet d’automatiser 
certains processus lors du stockage, de l’impression ou de la recherche sur les serveurs PACS 
et MWL. 

Les cases à cocher « Enable Single-Click Auto Store » (Activer le stockage automatique en un 
seul clic), « Print » (Imprimer) ou « MWL Connection » (Connexion MWL) permettent à 
l’utilisateur de stocker ou d’imprimer des images ou de se connecter automatiquement au 
serveur MWL. Si vous utilisez un seul serveur PACS pour ces actions ou si la majorité de votre 
travail concerne un seul serveur PACS, cochez la case souhaitée pour automatiser ces actions. 

La case « Enable Auto Search When Connecting to MWL Server » (Activer la recherche 
automatique lors de la connexion au serveur MWL) indique à l’application d’effectuer 
automatiquement une recherche avec les paramètres de recherche par défaut lors de la 
recherche des données du patient. 

La case « Auto close dialog after N seconds of successful transfer/printing » (Fermeture 
automatique de la boîte de dialogue après N secondes de transfert/impression réussi) ferme 
automatiquement la boîte de dialogue du réseau DICOM après un nombre de secondes 
spécifié. La boîte de dialogue ne se ferme pas automatiquement en cas d’erreur de transfert ou 
d’impression. 

Cliquez sur le boutonDICOM Servers (Serveurs DICOM) pour ouvrir la boîte de dialogue 
« DICOM Networking » (Réseau DICOM), dans laquelle l’utilisateur peut ajouter, modifier ou 
supprimer des serveurs DICOM (voir Figure 5.7.5). 

DICOM Save Local (Enregistrement DICOM local) 
Cette fonction permet d’enregistrer l’image actuelle sur un lecteur/répertoire local en cliquant 
avec le bouton droit de la souris n’importe où dans l’image. La boîte de dialogue présentée à la 
figure 5.7.4 ci-dessous est affichée. Cliquez sur « Save/Store current image » 
(Enregistrer/stocker l’image actuelle) puis sur « as Local DICOM image » (comme image 
DICOM locale). La boîte de dialogue « Windows File Save » (Enregistrement de fichiers 
Windows) standard est affichée. Parcourez ou cliquez sur le répertoire/dossier souhaité, 
saisissez le nom du fichier et cliquez sur Save (Enregistrer). 

 

 

 

 5.7.0 suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.7.4 
Boîte de dialogue Save Current 
Image (Enregistrer l’image 
actuelle) 
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PACS STORE (STOCKAGE PACS) et PACS PRINT (IMPRESSION 
PACS) 

Le logiciel Vision permet un stockage PACS (DICOM) et une impression PACS (DICOM). Ces 
options sont disponibles dans l’ensemble du logiciel. Par exemple, si le bouton PACS Store 
(Stockage PACS) est sélectionné, la boîte de dialogue « DICOM Networking Dialog » (Boîte de 
dialogue réseau DICOM) ci-dessous est affichée. Cette boîte de dialogue permet à l’utilisateur 
d’effectuer un stockage DICOM ou une impression DICOM, ainsi que d’ajouter, de modifier ou 
de supprimer des connexions réseau ou des périphériques DICOM. 

 

 

 

 

 

 

 

 

 

 

 

 

PACS DICOM STORE (STOCKAGE PACS DICOM) 
Le logiciel Vision prend en charge le service DICOM 3.0 C-STORE. Ceci permet d’envoyer une 
image ou une série d’images (selon une procédure spécifiée) à un système de stockage distant 
conforme à l’entité d’application (AE) DICOM, comme le PACS. Encore une fois, la fonction 
DICOM Store (Stockage DICOM) est accessible dans l’ensemble du logiciel Vision Les 
modifications de la présentation et du traitement peuvent être effectuées par le biais de la 
configuration de la modalité DICOM, dans le menu « Tools » (Outils).  

Remarque : pour le stockage DICOM, la case « SET FILM Attributes » (DÉFINIR les attributs 
DU FILM) est affichée en gris.  

L’utilisateur peut ajouter une nouvelle configuration pour une entité d’application DICOM (EA 
DICOM) distante à laquelle envoyer l’image ou choisir parmi une configuration déjà existante, 
affichée dans Connexions réseau DICOM, dans la boîte de dialogue « DICOM Networking 
Dialog » (Boîte de dialogue réseau DICOM). En double cliquant (ou avec un seul clic et en 
appuyant sur le bouton Connect) sur l’icône de l’EA DICOM distante, le logiciel Vision se 
connecte et établit une association DICOM avec l’EA distante sélectionnée. Une fois que 
l’association réussie, l’image peut être envoyée pour être stockée en appuyant sur le bouton 
« Store » (Stocker). Après avoir sélectionné le bouton « Store » (Stocker), le logiciel Vision 
envoie l’image sélectionnée à l’EA DICOM distante définie. Si l’opération de stockage est 
réussit, l’AE DICOM distant envoie une confirmation de réception et de stockage de la ou des 
images. Si l’opération échoue, l’EA DICOM distante envoie un code d’erreur indiquant la raison 
de l’échec. 

Une seule image peut également être envoyée pour être stockée en cliquant avec le bouton 
droit de la souris sur la vignette de l’image (dans le navigateur de la base de données) et en 
suivant la même procédure que celle décrite précédemment. Il est possible d’envoyer une série 
entière (procédure) d’images pour être stockées. Pour ce faire, cliquez avec le bouton droit de 
la souris sur le nom de la série (Procédure), affiché dans l’écran du navigateur de base de 
données, puis suivez le même protocole que celui décrit ci-dessus. 

 5.7.0 suite 
 
 
 
 
 
 
 
 
 
Figure 5.7.5 
Boîte de dialogue DICOM 
Networking Dialog (Boîte de 
dialogue réseau DICOM) 
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Add Session (Ajouter une session) 
Le bouton Add Session (Ajouter une session) ouvre la boîte de dialogue session dans laquelle 
l’utilisateur peut configurer une nouvelle connexion à une entité d’application DICOM distante. 

Pour créer une nouvelle configuration de connexion à une EA DICOM distante, l’utilisateur doit 
disposer des informations suivantes : le titre de l’entité d’application (titre de l’EA), le choix de 
la « fonction à exécuter » DICOM/PACS sélectionnée, l’adresse IP et le numéro de port du 
serveur (c’est-à-dire, de l’imprimante DICOM ou du système PACS). 

Le titre AE et le numéro de port du système de l’utilisateur (c’est-à-dire, le client) sont également 
nécessaires. Remplissez les champs de données correspondants et sélectionnez OK pour 
créer une nouvelle configuration. 

Choix du comportement de la fonction de session DICOM/PACS 
par défaut 

Il existe actuellement quatre (4) types de fonctions qu’une session DICOM peut utiliser par 
défaut. Celles-ci se trouvent dans la liste déroulante « Function » (Fonction) (case combinée) 
comme indiqué dans les figures ci-dessous. Les types de fonctions sont les suivants : 

1. Connexion GENERAL (GÉNÉRALE) 
DICOM/PACS 

2. Connexion DICOM STORE (STOCKAGE 
DICOM) 

3. Connexion PRINTER (IMPRIMANTE) 
DICOM 

4. Connexion WORKLIST (LISTE DE 
TRAVAIL) de la modalité 

 
 

 

 

 

Le but de la « fonction » DICOM est de permettre la création (l’ajout) d’une session/connexion 
qui permet d’utiliser un « dispositif » DICOM/PACS uniquement lorsque l’utilisateur l’a configuré 
pour une catégorie de fonctions particulières. Une fois configurée, lorsque vous affichez ou 
utilisez la boîte de dialogue « DICOM Networking Dialog » (Boîte de dialogue réseau DICOM) 
(voir Figure 5.7.5 ci-dessus), seule l’icône correspondant à la fonction choisie sera « active et 
illuminée » par une couleur bleue, par opposition à une couleur grise. Par exemple, la figure 
5.7.5 ci-dessus montre trois (3) icônes représentant, dans l’ordre, un stockage PACS (DICOM 
Store 1), une impression PACS (DICOM Print 1) et une liste de travail de modalité (DICOM-
MWL). Comme le bouton DICOM Store (Stockage DICOM) a été sélectionné précédemment, 
il est le seul icône actif (écran bleu). Les autres modes fonctionnent de la même manière. 

Modify Session (Modifier la session) 
Le bouton Modify Session (Modifier la session) ouvre la boîte de dialogue de l’EA DICOM 
sélectionnée. Dans cette fenêtre, l’utilisateur peut modifier les informations du serveur et du 
client indiquees dans la section « Add Session » (Ajouter une session). 

 

 5.7.0 suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.7.6 
Boîte de dialogue Session 
Properties (Propriétés de la 
session) 
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Remove Session (Supprimer la session) 
Le bouton Remove Session (Supprimer la session) supprime la configuration de l’EA DICOM 
sélectionnée du logiciel Vision. Une fois supprimée, une configuration de l’EA DICOM ne peut 
pas être restaurée, à moins que l’utilisateur ne saisisse à nouveau manuellement les données 
requises en utilisant le bouton « Add Session » (Ajouter une session). Une confirmation de 
l’action sera demandée (voir ci-dessous). 

 
 
 
 
 
 
 
 
 
 
 

DICOM Association (Association DICOM) 
Le bouton Association List (Liste des associations) ouvre la boîte de dialogue « DICOM 
Association » (Association DICOM) montrée ci-dessous, dans laquelle l’utilisateur peut modifier 
les paramètres et protocoles utilisés par le logiciel Vision lors de la négociation d’une connexion 
avec une EA DICOM distante. Ces options doivent être modifiées uniquement par un utilisateur 
avancé, familiarisé avec les protocoles d’association DICOM. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 5.7.0 suite 
 
 
 
 
 
 
Figure 5.7.7 
Vérification de la suppression 
d’une connexion réseau DICOM 
existante 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.7.8 
Fenêtre DICOM Association 
(Association DICOM) 
 
 
 



 
 

MANUEL DE L’UTILISATEUR DU FAXITRON PATH | HOLOGIC | RÉVISION 002   

SECTION 
Logiciel VISION 5 

5-38 

Attributs du film 
Sélectionnez « DICOM Print Film Attributes » (Attributs d’impression de film DICOM) dans le 
menu « Command » (Commande) (Figure 5.7.9) pour afficher la boîte de dialogue « DICOM 
Printer Setup » (Configuration de l’imprimante DICOM) (voir Figure 5.7.10). Dans cette boîte 
de dialogue, l’utilisateur peut sélectionner différentes options régissant le film et le format 
d’impression. La sélection de l’option Default (Par défaut) rétablit toutes les options par défaut. 
La configuration des paramètres est effectuée avec les menus déroulants. Pour accepter la 
configuration modifiée, sélectionnez OK. Pour rejeter les options et quitter la boîte de dialogue 
sans apporter aucune modification, sélectionnez Cancel (Annuler). 

 
 

 5.7.0 suite 
 
 
 
 
 
 
 
 
 
Figure 5.7.9 
Définir les attributs d’impression 
de film DICOM 
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IMPRESSION PACS 
L’option PACS Print (Impression PACS) envoie l’image sélectionnée à l’imprimante DICOM 
PACS sélectionnée. L’image est imprimée selon les options de format et d’impression de film 
spécifiées dans la boîte de dialogue « Set Film Attributes » (Configurer les attributs du film) 
décrite précédemment. Si l’utilisateur lance l’impression PACS à partir de « Image View » (Vue 
d’image), le niveau de fenêtre sera choisi dans « Image View » (Vue d’image). Si l’impression 
PACS est lancée à partir de la boîte de dialogue « Database » (Base de données), le niveau 
de fenêtre par défaut calculé par le logiciel Vision sera utilisé. 

 

Close (Fermer) 
Le bouton Close (Fermer) ferme la boîte de dialogue « DICOM Networking Dialog » (Boîte de 
dialogue réseau DICOM) et renvoie l’utilisateur à la zone à partir de laquelle la commande 
DICOM a été exécutée. Cette commande ferme également la connexion ou l’association entre 
le logiciel Vision et le périphérique DICOM distant si une connexion a été établie. 

 

 5.7.0 suite 
 
Figure 5.7.10 
Boîte de dialogue DICOM Printer 
Setup (Configuration de 
l’imprimante DICOM) 
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Overview (Vue d’ensemble) 
L’option « User Annotations » (Annotations de l’utilisateur) dans le logiciel Vision permet 
d’appliquer une « superposition » graphique transparente sur une image, communément 
appelée « annotation ». Ces annotations peuvent être un texte, des lignes, des lignes de 
« forme libre » (courbes de Bézier), des flèches, des ellipses et des boîtes. Cela permet 
d’ajouter des informations supplémentaires et des « marqueurs » sur l’image, au besoin. Notez 
que toutes les annotations peuvent être facilement activées ou désactivées, en d’autres termes, 
elles peuvent être affichées ou masquées à volonté. 

 

Fonctionnement 
Pour commencer l’annotation, sélectionnez l’outil Annotations (Annotations) dans le menu de 
gauche (voir Figures 5.4.1 et 5.8.1). En ouvrant cette boîte de dialogue, le logiciel mettra 
immédiatement l’utilisateur en mode de conception. Il affichera également une « palette 
d’outils » (voir Figure 5.8.2 ci-dessous).  
 

 

Le fait de sélectionner Save (Enregistrer) ou Cancel (Annuler) dans cette boîte de dialogue 
annulera les annotations précédentes ou enregistrera les annotations actuelles dans la fenêtre. 
Il vous ramène également au mode d’imagerie normal. 

La palette d’outils comprend les quinze (15) options d’outils suivantes. Cependant, l’utilisateur 
peut choisir d’afficher les 8 outils les plus courants, selon ses besoins; dans la ligne supérieure 
de la boîte de dialogue.  

Notez que le comportement de la plupart de ces options d’outils implique l’utilisation de la souris 
pour guider la position et la forme dynamiques à l’écran. Les « clics » de la souris sont utilisés 
pour définir les positions et les formes finales. Le terme « glisser » signifie que l’on maintient le 
bouton gauche de la souris enfoncé et que l’on déplace l’objet sur l’écran. Le fait de relâcher le 
bouton gauche de la souris ou de cliquer sur le bouton droit de la souris fixe l’annotation en 
position « permanente » ou finale. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Le texte suivant présente une description de chaque option d’outil en commençant dans le coin 
supérieur gauche de la figure ci-dessus. 

 5.8.0 
Annotations de 
l’utilisateur 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.8.1 
Icône d’annotation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.8.2 
Palette d’outils de conception des 
annotations de l’utilisateur 
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• Outil de sélection : cette option permet de sélectionner (surligner) l’objet d’annotation en 
cours. Cliquez sur le bouton gauche de la souris et maintenez-le enfoncé pour définir une 
position de départ, puis déplacez la souris. Les annotations contenues dans la boîte affichée 
seront sélectionnées pour une utilisation ultérieure. Relâchez le bouton gauche de la souris 
pour terminer l’opération. 

• Outil de ligne : cette option permet de tracer une ligne droite. Le comportement de la souris 
est le même que ci-dessus. 

• Outil de boîte : cette option permet de dessiner une boîte. Le comportement de la souris est 
le même que ci-dessus. 

• Outil d’ellipse (et de cercle) : cette option permet de dessiner une ellipse ou un cercle. Le 
comportement de la souris est le même que ci-dessus. 

• Outil de flèche : cette option permet de tracer une ligne avec une flèche à son extrémité. Le 
comportement de la souris est le même que l’outil de ligne. 

• Outil de ligne ouverte en polygone : cette option permet de dessiner des lignes non droites 
« à segments ouverts ». Cliquez sur le bouton gauche de la souris et maintenez-le enfoncé, 
et dessinez. Relâchez le bouton gauche pour définir un segment de ligne. Répétez l’opération 
autant de fois que désiré. Cliquez sur le bouton droit de la souris pour terminer la conception. 

• Outil de texte : cette option permet de créer une « zone de texte » dans laquelle vous 
pouvez saisir des données sous forme de texte. 

• Outil de règle : cette option permet de créer un segment de ligne gradué. Très similaire à la 
fonction Règle des outils d’image. 

• Outil de ligne fermée en polygone : cette option permet de dessiner des lignes non droites 
« à segments fermés ». Cliquez sur le bouton gauche de la souris et maintenez-le enfoncé, 
et dessinez. Relâchez le bouton gauche pour définir un segment de ligne. Répétez l’opération 
autant de fois que désiré. Cliquez sur le bouton droit de la souris pour terminer la conception. 

• Outil de ligne courbe ouverte : cette option permet de dessiner des lignes courbes 
« ouvertes et segmentées » (courbes de Bézier). Cliquez sur le bouton gauche de la souris 
et maintenez-le enfoncé, et dessinez. Relâchez le bouton gauche pour définir un segment 
de ligne courbe. Répétez l’opération autant de fois que désiré. Cliquez sur le bouton droit de 
la souris pour terminer la conception. 

• Outil de ligne courbe fermée : cette option permet de dessiner des lignes courbes 
« fermées et segmentées » (courbes de Bézier). Cliquez sur le bouton gauche de la souris 
et maintenez-le enfoncé, et dessinez. Relâchez le bouton gauche pour définir un segment 
de ligne courbe. Répétez l’opération autant de fois que désiré. Cliquez sur le bouton droit de 
la souris pour terminer la conception. 

• Outil d’infobulle (texte) : cette option permet de créer une zone de texte avec un segment 
de ligne dépassant d’un coin de la zone de texte. Cela peut être utilisé pour « lier » du texte 
à un élément sur votre image. 

• Outil de règle segmentée : cette option permet de dessiner des lignes graduées non droites 
« ouvertes et segmentées ». Cliquez sur le bouton gauche de la souris et maintenez-le 
enfoncé, et dessinez. Relâchez le bouton gauche pour définir un segment de ligne graduée. 
Répétez l’opération autant de fois que désiré. Cliquez sur le bouton droit de la souris pour 
terminer la conception. La longueur de tous les segments de ligne gradués est indiquée à 
l’extrémité de la règle. Cet outil est utile pour une estimation approximative de la 
circonférence d’un objet ou d’un patient. 

• Outil de rapporteur : cette option permet de dessiner un angle sur l’écran et indique la valeur 
de l’angle en degrés, tout comme un rapporteur. 

• Outil de règle orthogonale : cette option permet de dessiner deux (2) lignes graduées 
orthogonales l’une par rapport à l’autre.  

 

 5.8.0 suite 
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Mode de conception et menu contextuel (clic droit de la souris) 
 
En mode « User Annotation Design » (Conception d’annotations utilisateur), mais pas dans un 
mode de fonctionnement spécifique, il est possible cliquer à droite sur la souris pour afficher un 
menu contextuel (voir ci-dessous). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
De nombreux réglages spécifiques peuvent être effectués à partir de ces menus contextuels. 
 
Notez que si un élément semble trop petit pour être lu ou vu correctement, vous pouvez 
éventuellement le modifier à partir des menus contextuels présentés ci-dessus. Vous pouvez 
également choisir d’effectuer un zoom sur l’image à l’aide de l’outil Digital Zoom (Zoom 
numérique). Cela agrandit l’image pour vous permettre de voir clairement toutes les annotations. 
 
 

Afficher – Masquer les annotations 
 
Le bouton Toggle Annotations (Basculer les annotations), présenté à la Figure 
5.8.4, permet aux utilisateurs d’activer et de désactiver rapidement les annotations. 
Les annotations sont activées par défaut. Le bouton est situé dans le menu de droite, 
près du coin supérieur droit. 
 
 
 
Le sous-menu « Help » (Aide) situé dans la barre de menu supérieure (Figure 5.9.1) permet 
d’accéder rapidement au Manuel de l’utilisateur du Faxitron Path et à la boîte de dialogue 
« About Vision » (À propos de Vision). Consultez la Section 5.10.0 et la Figure 5.10.1. 
 
 

 5.8.0 suite 
 
 
 
 
 
Figure 5.8.3 
Menu contextuel de la souris (clic 
droit) (uniquement en mode de 
conception des annotations de 
l’utilisateur) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.8.4 
Option Show/Hide 
(Afficher/Masquer) pour les 
annotations de l’utilisateur 
 
 
 
5.9.0 
À propos de Help 
(Aide) 
 
Figure 5.9.1 
Boîte de dialogue Help (Aide) en 
ligne 
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Le bouton « About Vision » (À propos de Vision) ouvre une boîte de dialogue qui affiche la 
version du logiciel Vision, la date d’enregistrement des droits d’auteur et les informations sur le 
système. 
 

 5.10.0 
À propos du 
logiciel Vision 
 
Figure 5.10.1 
Boîte de dialogue About Vision (À 
propos de Vision) 
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SECTION 6 
Exigences de conformité et 

mesures de sécurité 
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Exigences | conformité du Faxitron Path 
 
Limites d’émission 
Le rayonnement émis par l’unité Faxitron Path ne dépasse pas une exposition de 0,1 milli-
Roentgen (mR) par heure en un point quelconque situé à 5 centimètres (cm) à l’extérieur de 
la surface externe. Pour les pays exigeant des valeurs d’émission mesurées à 10 cm des 
surfaces externes, le rayonnement ne dépasse pas 0,1 mR à 10 cm. 
 
Dispositifs de verrouillage de sécurité 
Le système de radiographie numérique d’échantillons Faxitron Path est muni de deux 
dispositifs de verrouillage de sécurité situés sur la porte du compartiment à échantillons. 
 
Bouton de démarrage 
Après l’interruption de la génération de rayons X par les dispositifs de verrouillage de sécurité, 
le bouton « Start » (Démarrage) du panneau avant reprendra la génération de rayons X 
lorsque le système sera prêt. 
 
Commande par clé 
Un interrupteur à clé situé sur le panneau avant nécessite l’insertion d’une clé, et sa rotation 
dans le sens des aiguilles d’une montre à la position de « 3 heures », pour mettre sous tension 
le système de l’armoire. La clé ne peut pas être retirée en position « MARCHE ». 
 
Bouton d’arrêt d’urgence 
Le bouton d’arrêt d’urgence situé sur le panneau avant du Faxitron Path permet d’interrompre 
la génération de rayons X. Cette mesure s’ajoute aux dispositifs de verrouillage de sécurité 
des portes du système. 
 
Voyants de génération de rayons X 
Le Faxitron Path est muni d’un voyant lumineux d’activation de rayons X sur le panneau avant 
et sur l’interface graphique de l’utilisateur. Il émet également un signal sonore pendant la 
génération de rayons X. 
 
Puissances nominales 
100-240V CA, 50/60 HZ, 200 W MAX. 
 
Production de chaleur 
500 BTU/h max. 
 
LOCALISATEUR DU LASER 
Le Faxitron Path utilise une paire de lignes générées par laser pour faciliter le positionnement 
des échantillons au milieu du champ d’imagerie.  
 
Paramètres des lasers 
Les lasers sont conformes à la norme CEI 60825-1 Éd. 3. 
Produits laser de classe 2 
Longueur d’onde : 670 nm 
Puissance maximale : 1 mW 
Largeur des lignes : 1 mm standard 
Divergence du faisceau : 85 degrés standard 
 
Les lasers ne nécessitent aucun assemblage. 
 
L’utilisateur n’est pas autorisé à effectuer l’entretien des lasers. L’entretien des lasers doit être 
effectué uniquement par un représentant autorisé de Hologic. 
 
PARAMÈTRES ÉLECTRIQUES DES LASERS 
Tension de fonctionnement : Rouge : 3-6 V CC 
 Noir : terre 
Courant de fonctionnement : 50 mA standard 
 80 mA max. 
 

 6.1.0 
Exigences de 
conformité et 
mesures de 
sécurité 
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MISES EN GARDE : 
RAYONNEMENT LASER DE CLASSE 2 LORSQUE LA PORTE EST OUVERTE. NE FIXEZ 
PAS LE FAISCEAU. 
 
Un faisceau laser peut endommager les yeux, NE REGARDEZ PAS dans l’ouverture du 
laser lorsque le laser est en fonctionnement. 
 
La lumière laser peut également être dangereuse lorsqu’elle est réfléchie sur une surface 
similaire à un miroir. 
 
 Pour obtenir plus d’informations sur la sécurité des lasers, consultez à la norme ANSI-Z1 
36.1 STANDARD FOR THE SAFE USE OF LASERS (NORME POUR L’UTILISATION 
SÉCURITAIRE DES LASERS), disponible auprès du Laser Institute of America, au numéro 
de téléphone 407-380-1553. 
 
REMARQUE : les ouvertures du laser sont situées dans le plafond du compartiment à 
rayons X. 
 
 
 
Étiquette de MISE EN GARDE sur le laser : Situé dans le coin supérieur droit de la porte et 
derrière la porte. 
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Version DICOM 
 
Hologic utilise la norme DICOM la plus récente : 
ACR-NEMA Digital Imaging and Communications in Medicine (DICOM) v3.0, 
version finale, août 1993. 
 
Hologic est conforme aux normes suivantes :  
NEMA PS 3.1 - 3.20 (2016), Digital Imaging and Communications in 
Medicine Set 
 
 
Classes de stockage 
 
FAXITRON_DR procure une conformité standard à la classe de Parité 
objet/service (SOP) DICOM V3.0 suivante en tant qu’utilisateur (Service Class 
User ou SCU). 
 
Classe de Parité objet/service (SOP) du SCU 

 
Classe de Parité objet/service (SOP) ID unique de la classe de SOP 

SOP de stockage des images 
radiographiques numérisées 

1.2.840.10008.5.1.4.1.1.1 

Présentation du stockage des images 
radiographiques numérisées 

1.2.840.10008.5.1.4.1.1.1.1 

Traitement du stockage des images 
radiographiques numérisées 

1.2.840.10008.5.1.4.1.1.1.1.1 

Présentation du stockage des images 
de mammographie numérisées 

1.2.840.10008.5.1.4.1.1.1.2 

Traitement du stockage des images de 
mammographie numérisées 

1.2.840.10008.5.1.4.1.1.1.2.1 

Informations sur la requête/récupération 
de la racine de l’étude. Modèle - FIND 

1.2.840.10008.5.1.4.1.2.2.1 

Informations sur la requête/récupération 
de la racine du patient. Modèle - FIND 

1.2.840.10008.5.1.4.1.2.1.1 

Informations sur la liste de travail de 
modalité Modèle - FIND 

1.2.840.10008.5.1.4.31 

Stockage de la version électronique de 
l’échelle de gris 

1.2.840.10008.5.1.4.1.1.11.1 

 
 

Pour obtenir plus d’informations, consultez à la déclaration de conformité 
DICOM complète enregistrée sur le système. Le fichier se trouve dans 
C:\Faxitron et un raccourci est fourni sur le bureau.  
 
Si nécessaire, une copie de la déclaration de conformité DICOM est disponible 
sur demande auprès de Hologic. 

  6.2.0 
Norme DICOM 
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Entretien 
 
Il n’y a aucune pièce réparable dans l’équipement Hologic. Veuillez contacter votre représentant 
Hologic agréé pour toute réparation.  
 

ÉTATS-UNIS : +1 877 371 4372 

Europe : +32 2 711 4690 

Asie : +852 37487700 

Australie : +1-800-264-073 

Tous les autres : +1 781 999 7750 

Adresse courriel : BreastHealth.Support@hologic.com 
 
 
 
Dépannage 
 
L’ordinateur ou le système ne s’allume pas 
Aucune alimentation électrique de l’ordinateur ou du système de radiographie.  
Vérifiez que le système est sous tension (MARCHE) et que les câbles d’alimentation sont 
branchés et sous tension. 
 
Le voyant READY (PRÊT) ne reste pas allumé 
Le bouton a été pressé AVANT avant que le logiciel Vision ne soit lancé ou avant que le logiciel 
n’arme le système de radiographie pour une acquisition (voir Démarrage rapide). 
 
L’image semble indiquer qu’il y a un autre objet dans le compartiment à rayons X 
Vérifiez qu’aucun autre objet n’était présent dans l’armoire à rayons X pendant l’étape 
« Calibration » (Étalonnage). Retirez les objets et répétez l’étape Calibration (Étalonnage). 
 
Mauvaise qualité des images  
Vérifiez que les valeurs d’intensité de l’image (I (x,y)) situées dans le coin inférieur droit de la 
fenêtre d’affichage de l’image sont près de l’intensité cible en ADU de 10 000 ADU lorsque la 
cible du contrôle automatique de l’exposition (AEC; Automatic Exposure Control) de la pré-
image est également réglée sur 10 000 ADU et que le mode d’exposition sélectionné est 
« Auto kV/Auto Time ». Si nécessaire, répétez la procédure Imaging (Imagerie). 
 
 
 
Cybersécurité 
Si un événement lié à la cybersécurité se produit, déconnectez le système du réseau et 
contactez immédiatement Hologic. Nous travaillerons avec votre département informatique 
pour résoudre le problème. 
 
Un événement lié à la cybersécurité peut être détecté de plusieurs façons : 

• Fonctionnement et/ou connexion réseau plus lents que la normale; 

• Fenêtres contextuelles suspectes ou page d’accueil modifiée dans le navigateur 
Internet; 

• Mot(s) de passe inopérant(s); 

• Programmes non identifiés dans le menu de démarrage ou dans la barre d’état du 
système; 

• Données manquantes, corrompues ou altérées. 

 

 7.1.0 
Entretien et 
dépannage  
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Ce document fournit un calendrier de test et de maintenance pour le Faxitron Path. Il est 
fortement recommandé que la maintenance et les tests décrits dans cette section soient 
effectués en respectant les intervalles de temps indiqués, pour s’assurer que votre générateur 
de rayons X Faxitron continue à fonctionner avec des performances optimales. 

 8.0.0 
Maintenance 
 

 
Avertissement : les échantillons des tissus peuvent contenir des agents 
infectieux dangereux pour votre santé. Respectez les procédures de biosécurité 
appropriées et portez des gants lors de la manipulation des échantillons de tissus 
ou des matériaux avec lesquels ils sont entrés en contact. 
  
Essuyez régulièrement l’intérieur de l’armoire avec de l’alcool isopropylique à 70-90 % ou de 
l’hypochlorite de sodium dilué (5,25-6,15 % d’eau de Javel domestique diluée à 1:500 fournit 
la concentration appropriée). Assurez-vous que la zone de l’échantillon, marquée sur le sol du 
compartiment, est nettoyée à fond. 
 
N’utilisez pas de l’acétone ou d’autres solvants agressifs sur la fenêtre de la porte du 
compartiment à rayons X. 
 

  
8.1.0 
Interne 

 
Essuyez régulièrement les surfaces externes avec de l’alcool isopropylique, de l’hypochlorite 
de sodium ou un savon doux et de l’eau (voir 8.1.0 ci-dessus pour connaître les concentrations 
appropriées). Ne trempez pas ou n’inondez pas les surfaces et n’utilisez pas d’abrasifs qui 
pourraient rayer les surfaces. Ne laissez pas l’humidité entrer en contact avec les composants 
électriques du système. Testez les produits de nettoyage sur une petite zone non visible des 
capots en plastique et en métal pour vérifier qu’ils n’endommagent pas le revêtement. 

  
8.2.0 
Externe 

 
À l’exception des câbles externes et des fusibles, le système ne comporte aucun composant 
remplaçable par l’utilisateur. Les éléments suivants peuvent être commandés et remplacés par 
le personnel de Hologic ou des représentants agréés. 
 

• Capteur de rayons X numérique 

• Carte d’interface PCIe 

• Ordinateur, moniteur, souris et clavier 

• Circuit imprimé de la commande  

• Tube à rayons X et alimentation HT 

• Alimentation de basse tension 

 

  
8.3.0 
Pièces 
remplaçables 

 
• Cible de diffusion en acrylique (0,25 po~ 6 mm et 1,0 po ~ 24 mm d’épaisseur) 
• Fantôme ACR (Nuclear Associates Réf. 18-250) 
• Radiamètre pour le compartiment d’ionisation, Inovision modèle 451B-DE-SI-RYR ou similaire 
• Bidon d’eau en plastique de 1 gallon (4 litres) 
 

  
8.4.0 
Matériel 
nécessaire 

 
Les références suivantes fournissent des informations qui amplifient ou augmentent les 
procédures de sécurité du logiciel, qui sont définies dans ce document. 
 
Sécurité et cybersécurité 
Toute mise à jour de logiciel ou micrologiciel effectuée depuis la dernière maintenance et qui 
résout un problème de sécurité ou de sûreté peut être fournie, si nécessaire. 
 
Le micrologiciel est codé en dur dans le circuit imprimé de la commande. Si une mise à jour du 
micrologiciel est nécessaire, remplacez la carte du circuit imprimé dans le panneau de 
commande. 

  
8.5.0 
Documents de 
référence et 
informations sur 
les versions 
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Les définitions suivantes s’appliquent aux termes énumérés ci-dessous lorsqu’ils sont 
mentionnés dans le présent calendrier de maintenance. 
 
Fantôme ACR : fantôme d’accréditation de l’American College of Radiology. 
 
ADU : Analog-to-Digital Units (unités analogiques-numériques). 
 
AEC : Automatic Exposure Control (Contrôle automatique de l’exposition) - L’ordinateur met 
fin à l’émission de rayons X lorsqu’un signal suffisant a atteint le capteur. 
 
Contraste : pourcentage de différence entre l’intensité de l’objet et l’intensité de l’arrière-plan. 
 
Courant d’obscurité : signal thermique généré dans le capteur qui est (presque) linéaire dans 
le temps. 
 
Champ plat : corrections de gain et de décalage effectuées pixel par pixel. Chaque pixel a un 
gain et un décalage différents et doit être étalonné. 
 
Paires de lignes par millimètre : nombre d’éléments de plomb et d’air alternés. Par exemple, 
10 lp/mm signifie => {air/plomb} {air/plomb} ... 10 fois par millimètre. 
 
Agrandissement : éloignement de l’objet du capteur et rapprochement de la source de 
rayons X pour agrandir l’image de l’objet sur le capteur. 
 
MTF : Modulation Transfer Function (Fonction de transfert de modulation). Mesure du 
contraste et de la résolution d’un système d’imagerie. 
 
Bruit de lecture : mesure du bruit RMS pendant une exposition sombre de 0 seconde (aucun 
signal). 
 
RI : région d’intérêt; habituellement une sous-région spécifique d’une image. 
 
DIS : distance source-image; distance entre la source de rayons X et le capteur. 
 
Radiographie d’échantillons : imagerie à rayons X d’un morceau de tissu après son 
prélèvement du corps. 

 8.6.0 
Définitions 

 
Une maintenance régulière doit être effectuée une fois par année pour garantir que votre 
système Faxitron Path continue de fonctionner de manière optimale au fil du temps. Cette 
maintenance régulière comprend la vérification des éléments suivants : 

• Dispositifs de verrouillage et indicateurs de sécurité (Section 8.8.0), 

• Test avec fantôme ACR (vérifie les performances de la caméra; Sections 8.8.1) et 

• Contrôle du rayonnement (Section 8.8.2). 

 

Nous recommandons que ces procédures soient effectuées une fois par année, mais les 
réglementations gouvernementales peuvent exiger des maintenances plus fréquentes.  

  
8.7.0 
Maintenance 
régulière 
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Dispositifs de verrouillage, voyants et messages d’erreur – Effectuer une fois 
par année 
 
Imprimez cette page pour l’utiliser comme référence si nécessaire. 

Enregistrez les résultats sous « Dispositifs de verrouillage et indicateurs de sécurité » dans le 
Registre de maintenance régulière – Faxitron Path, situé à la fin de la section. 

 

 8.8.0 
Dispositifs de 
verrouillage et 
indicateurs de 
sécurité 

1. Le système doit être sous tension. L’interrupteur à clé doit être en position « 3 heures » et 
la clé doit être impossible à retirer. 

 
2. Assurez-vous que le voyant « Power » (Alimentation) s’allume et qu’aucun autre voyant 

n’est allumé à ce moment-là.  
 
3. Assurez-vous que l’écran LCD s’allume et affiche « System Idle » (Système inactif) et qu’il 

n’y a aucun autre message, tel que « Door Open » (Porte ouverte) à ce moment-là.  
 
4. Ouvrez la porte du compartiment à échantillon. L’écran LCD affiche le message « Door 

Open » (Porte ouverte). Lorsque la porte est refermée, ce message doit disparaître. 
 
5. Allumez l’ordinateur et le moniteur. Le logiciel Vision devrait démarrer automatiquement. Si 

le logiciel ne démarre pas automatiquement, double-cliquez sur l’icône Vision Software 
(Logiciel Vision) pour lancer le logiciel d’imagerie. Si cela déclenche un étalonnage, laisser 
l’étalonnage s’achever complètement. 

 
6. Ensuite, cliquez sur le bouton « Start Procedure » (Démarrer la procédure), puis sur le 

bouton « Patient Data » (Données du patient) et choisissez le bouton « Enter Manually » 
(Saisir manuellement) pour accéder à l’écran de saisie du patient. Remplissez tous les 
champs marqués d’un astérisque (*), puis cliquez sur le bouton « Accept » (Accepter). Cela 
permettra d’effectuer une exposition. 

 
7. Vérifiez que le voyant « READY » (PRÊT) est allumé. L’écran LCD affichera également un 

message « READY » (PRÊT). 
 
8. Appuyez sur le bouton vert « X-ray » (Rayons X) situé à l’avant du Faxitron Path. Le 

système devrait commencer une exposition aux rayons X. Assurez-vous que l’écran LCD 
affiche l’indicateur à barres pour l’exposition, ainsi que la valeur de tension (kV) et la durée 
de l’exposition. Vérifiez également que le voyant « X-Ray on » (Rayons x activés) s’allume. 
Vous devriez également entendre un bref bip environ une fois par seconde pendant 
l’exposition. Laissez l’exposition s’achever et assurez-vous que l’image s’affiche sur l’écran 
de l’ordinateur. 

 
9. Appuyez de nouveau sur le bouton vert pour démarrer une autre exposition. Pendant 

l’exposition, appuyez sur le bouton rouge « Stop » (Arrêter) et l’exposition devrait s’arrêter 
en moins de 2 secondes. De plus, l’avertisseur sonore cessera de retentir pour indiquer que 
l’exposition a été arrêtée. Le logiciel affichera les erreurs d’interruption, ce qui est normal. 
Les erreurs peuvent être effacées, ce qui permet de reprendre l’émission des rayons X. 

 
10. Appuyez de nouveau sur le bouton vert et laissez l’exposition démarrer. Cette fois, ouvrez 

la porte du compartiment à échantillon, ce qui devrait désengager les interrupteurs de 
sécurité et forcer l’arrêt de l’exposition. SI le logiciel affiche des erreurs, effacez-les.  
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Fantôme ACR (insert en cire uniquement) – Effectuer une fois par année 
 
Imprimez cette page pour l’utiliser comme référence si nécessaire. 

Enregistrez les résultats sous « Test avec fantôme ACR » dans le Registre de maintenance 
régulière – Faxitron Path, situé à la fin de la section. 

 
L’utilisateur doit être familier avec l’utilisation du Faxitron Path et connaître les procédures de 
prise de radiographies. Après avoir terminé les procédures de configuration, assurez-vous que 
la caméra est étalonnée (notez la valeur de tension en kV et l’heure de l’étalonnage), saisissez 
les données du patient et prenez une photo de la partie de l’insert en cire du mini-fantôme ACR 
illustrée à la Figure 8.1. REMARQUE : l’insert en cire doit être retiré de son support en acrylique 
pour prendre l’image. 
 
 
 
 
Le mini-fantôme ACR contient 12 objets : 
4 masses, 4 fibres et 4 groupes de 
calcifications (taches). Chaque groupe 
de calcifications contient 6 calcifications 
ou taches individuelles. Toutes les 
masses, fibres et calcifications doivent 
être visibles. 
 
 
 
 
 
 
Remarque : le dernier groupe de 
calcifications pourrait ne pas être visible 
sur cette image. 
 
 
 
 
CRITÈRES D’ACCEPTATION 
 
1. Configurez le système pour prendre une image manuelle de l’insert en cire du mini-fantôme 

ACR. Réglez la tension (kV) et la durée sur les valeurs notées pendant l’étalonnage. 

2. Assurez-vous que le fantôme est propre et exempt de débris. 

3. Placez l’insert en cire directement sur le sol du compartiment, au milieu de la zone 
d’imagerie. N’utilisez aucun bloc d’atténuation. 

4. Démarrez l’exposition aux rayons X, attendez que tous les traitements soient achevés et que 
l’image soit affichée. 

5. Tous les objets du fantôme peuvent ne pas être visibles lorsque l’image est affichée pour la 
première fois. Ajustez les niveaux de contraste et de luminosité selon vos besoins pour 
obtenir une image optimale. 

6. Une fois l’image corrigée, tous les groupes d’objets doivent être visibles. 

7. Enregistrez les résultats dans le Registre de maintenance régulière. 

 
 

 8.8.1 
Test du fantôme 
ACR 
 
 
 
 
 
 
 
 
Figure 8.1 
Image radiographique typique de 
l’insert en cire du mini fantôme 
ACR (Nuclear Associates Réf. 
18-250) 
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Contrôle du rayonnement – Effectuer une fois par année ou si le dispositif est 
tombé ou endommagé. 
Les pages suivantes peuvent être imprimées et utilisées comme référence pour effectuer le 
contrôle du rayonnement. 

Enregistrez les résultats sous « Contrôle du rayonnement » dans le Registre de maintenance 
régulière – Faxitron Path, situé à la fin de la section. 

Le fabricant recommande d’effectuer un examen radiographique au moins une fois par année* 
pour s’assurer que les émissions de rayonnement sont conformes aux limites requises. Si la 
machine est endommagée de quelque manière que ce soit après l’installation,le contrôle du 
rayonnement doit être effectué avant de remettre la machine en service dans l’établissement. 

 

Outils nécessaires 
• Dispositif de contrôle du rayonnement avec source de contrôle (radiamètre pour le 

compartiment d’ionisation recommandé, comme l’Inovision modèle 451B); la source de 
contrôle est fournie avec le dispositif) 

• Un bidon d’eau en plastique de 1 gallon (4 litres). 

 

Vérification du fonctionnement du radiamètre 
1. Date d’étalonnage : Vérifiez que l’étalonnage du radiamètre est à jour. 

2. Vérification de la batterie : Vérifiez l’état de la batterie. Remplacez les batteries, si 
nécessaire. 

3. Vérification du fonctionnement : (Si la source de contrôle est disponible). Remarque : les 
étapes suivantes s’appliquent à l’Inovision 451B ou à des radiamètres pour compartiment 
d’ionisation similaires. Suivez les instructions du fabricant pour les autres radiamètres. 

• Ouvrez le blindage coulissant contre les rayons bêta située au bas du radiamètre. 

• Placez le multimètre sur la source de contrôle et le surveillez pendant 30 secondes. 

• Le radiamètre doit donner des valeurs situées dans la plage de tolérance indiquée sur 
l’étiquette d’étalonnage. 

• Enregistrez les valeurs dans le Registre de maintenance régulière. 

• Refermez le blindage contre les rayons bêta du radiamètre. 

 

Remarques importantes 
1. Toutes les mesures de rayonnement sont prises en positionnant le radiomètre à une distance 

maximale de 5 cm (2 pouces) de la surface de l’unité Faxitron Path. 

2. Lors de l’enregistrement des valeurs de rayonnement, il peut être nécessaire de les multiplier 
par 0,1 pour convertir la lecture de uSv/h en mR/h. Par exemple, 12 uSv/h est égal à 1,2 mR/h. 

 

 8.8.2 
Contrôle du 
rayonnement 



 
 
 

MANUEL DE L’UTILISATEUR DU FAXITRON PATH | HOLOGIC | RÉVISION 002  

SECTION 
Calendrier de 
maintenance 8 

8-7 

Procédure de contrôle du rayonnement 
 
1. Mesurez le rayonnement de fond (pointez le mètre vers le centre de la pièce) et notez la 

valeur. 

2. Configurez le système pour prendre une image manuelle. 

a. Cliquez sur le bouton « Device Panel » (Panneau du dispositif) et sélectionnez « Full 
Manual » (Entièrement manuel). 

b. Faites glisser les curseurs « kV » et « Time » (durée) vers l’extrême droite pour 
maximiser les valeurs de kV et de durée sélectionnées. 

c. Cliquez sur le bouton « Set » (Définir). 

3. Vérifiez que le voyant « READY » (PRÊT) est allumé. 

4. Ouvrez la porte du compartiment. Placez le bidon d’eau en plastique de 1 gallon (4 litres) au 
sol dans la zone d’imagerie du compartiment et fermez la porte. 

5. Appuyez sur le bouton « START » (DÉMARRER) et mesurez les émissions de rayonnement 
au sommet, à l’avant, à l’arrière et des deux côtés de l’armoire. Balayez lentement toute la 
surface avec le radiamètre. Chaque balayage doit comporter 1 ou 2 expositions aux 
rayons X. Remarque : vous devrez lancer plusieurs émissions de rayons X pour compléter 
le contrôle du rayonnement. 

6. Enregistrez les valeurs pour chaque emplacement du test. 

7. Si l’une des valeurs est supérieure à la limite d’émission de rayonnement de Hologic de 
0,1 milli-Roentgen (mR) par heure (1,0 μSv/h) en un point quelconque situé à 5 centimètres 
(cm) à l’extérieur de la surface externe (*), contactez un représentant de Hologic pour 
discuter des options de réparation. 

(*) 0,5 mR/h à 5 cm des surfaces externes est la limite supérieure fixée par le Center 
for Devices and Radiological Health (CDRH) de la Food and Drug Administration des 
États-Unis pour les équipements de rayons X montés dans une armoire. Si le dispositif 
est utilisé dans un autre pays, veuillez vérifier les limites officielles du pays pour les 
équipements à rayons X montés dans une armoire qui sont utilisés à des fins de 
diagnostic in vitro. 

Pour certains pays, les points de test doivent effectués à 10 cm des surfaces externes, 
et dans ce cas, l’émission de rayonnement du Faxitron doit être inférieure à 0,1 mR/h à 
10 cm des surfaces externes. 

8. Retirez le bidon d’eau du compartiment à rayons X.  

9. Le sol de l’armoire à rayons X doit être examiné si le système est placé sur une table ou si 
du personnel est présent à l’étage inférieur, sous le système. Vérifiez que le compartiment à 
rayons X est vide, démarrez une radiographie et balayez le bas de l’armoire. Enregistrez la 
valeur. 

 

 8.8.2 suite 
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Registre de maintenance régulière - Faxitron Path   
N° de série du système : _______  Numéro de série de la caméra : _______  

 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

La maintenance régulière susmentionnée a été effectuée par : ____________________________________  
 
Date de l’exécution : ____________  Signature : ______________________________________________  

Dispositifs de verrouillage et indicateurs de sécurité – conformément à la Section 8.8.0 

Réussite : ___  Échec : ___________  Initiales : ___________  Date : _____________  

En cas d’échec, indiquer la raison et les mesures prises pour corriger l’échec. 

 ________________________________________________________________________________  

 ________________________________________________________________________________  

 ________________________________________________________________________________  

Initiales : ___________  Date : ______________  
 
 Test avec fantôme ACR – conformément à la Section 8.8.1 

Nombre d’objets observés : Masses : _____  Fibres : _____  Groupes de calcification : _____  

Réussite : ___  Échec : _________  Initiales : ___________  Date : _____________  

En cas d’échec, indiquer la raison et les mesures prises pour corriger l’échec. 

 ________________________________________________________________________________  

 ________________________________________________________________________________  

 ________________________________________________________________________________  

Initiales : ___________  Date : ______________  
 
 Contrôle du rayonnement – conformément à la Section 8.8.2 

Lectures de rayonnement en : mR/h µSv/h   Source de contrôle : ______  Fond : _______  

Avant : ______  Côté droit : ____________  Dessus : ____________  

Arrière : _____  Côté gauche : __________  Dessous :___________  

Réussite : ___  Échec : ________  Initiales : ___________  Date : _____________  

En cas d’échec, indiquer la raison et les mesures prises pour corriger l’échec. 

 ________________________________________________________________________________  

 ________________________________________________________________________________  

 ________________________________________________________________________________  

Initiales : ____________  Date : ______________  
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